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SPECTRACOM LIMITED WARRANTY 

 
LIMITED WARRANTY 

Spectracom warrants each new product manufactured and 
sold by it to be free from defects in software, material, 
workmanship, and construction, except for batteries, fuses, or 
other material normally consumed in operation that may be 
contained therein AND AS NOTED BELOW, for five years after 
shipment to the original purchaser (which period is referred to 
as the “warranty period”). This warranty shall not apply if the 
product is used contrary to the instructions in its manual or is 
otherwise subjected to misuse, abnormal operations, accident, 
lightning or transient surge, repairs or modifications not 
performed by Spectracom. 

The GPS receiver is warranted for one year from date of 
shipment and subject to the exceptions listed above. The 
power adapter, if supplied, is warranted for one year from date 
of shipment and subject to the exceptions listed above. 

THE TIMEVIEW ANALOG CLOCKS ARE WARRANTED FOR 
ONE YEAR FROM DATE OF SHIPMENT AND SUBJECT TO 
THE EXCEPTIONS LISTED ABOVE. 

THE TIMECODE READER/GENERATORS ARE 
WARRANTED FOR ONE YEAR FROM DATE OF SHIPMENT 
AND SUBJECT TO THE EXCEPTIONS LISTED ABOVE. 

THE WIRELESS CLOCK SYSTEM TRANSMITTERS AND/OR 
TRANSCEIVERS AND CLOCKS ARE WARRANTED FOR 
TWO YEARS FROM DATE OF SHIPMENT AND SUBJECT 
TO THE EXCEPTIONS LISTED ABOVE. 

THE EPSILON CLOCKS, BOARDS, AND 
SYNCHRONIZATION UNITS ARE WARRANTED FOR TWO 
YEARS FROM DATE OF SHIPMENT AND SUBJECT TO THE 
EXCEPTIONS LISTED ABOVE. 

The Rubidium oscillator, if supplied, is warranted for two years 
from date of shipment and subject to the exceptions listed 
above. 

All other items and pieces of equipment not specified above, 
including the antenna unit, antenna surge suppressor and 
antenna pre-amplifier are warranted for 5 years, subject to the 
exceptions listed above. 

WARRANTY CLAIMS  

Spectracom’s obligation under this warranty is limited to in-
factory service and repair, at Spectracom’s option, of the 
product or the component thereof, which is found to be 
defective. If in Spectracom’s judgment the defective condition 
in a Spectracom product is for a cause listed above for which 
Spectracom is not responsible, Spectracom will make the 
repairs or replacement of components and charge its then 
current price, which buyer agrees to pay. 

Spectracom shall not have any warranty obligations if the 
procedure for warranty claims is not followed. Users must 
notify Spectracom of the claim with full information as to the 
claimed defect. Spectracom products shall not be returned 
unless a return authorization number is issued by Spectracom.  

Spectracom products must be returned with the description of 
the claimed defect and identification of the individual to be 
contacted if additional information is needed. Spectracom 
products must be returned properly packed with transportation 
charges prepaid. 

Shipping expense: Expenses incurred for shipping 
Spectracom products to and from Spectracom (including 
international customs fees) shall be paid for by the customer, 
with the following exception. For customers located within the 
United States, any product repaired by Spectracom under a 
“warranty repair” will be shipped back to the customer at 
Spectracom’s expense unless special/faster delivery is 
requested by customer. 

Spectracom highly recommends that prior to returning 
equipment for service work, our technical support department 
be contacted to provide trouble shooting assistance while the 
equipment is still installed. If equipment is returned without first 
contacting the support department and “no problems are 
found” during the repair work, an evaluation fee may be 
charged. 

EXCEPT FOR THE LIMITED WARRANTY STATED ABOVE, 
SPECTRACOM DISCLAIMS ALL WARRANTIES OF ANY 
KIND WITH REGARD TO SPECTRACOM PRODUCTS OR 
OTHER MATERIALS PROVIDED BY SPECTRACOM, 
INCLUDING WITHOUT LIMITATION ANY IMPLIED 
WARRANTY OR MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. 

Spectracom shall have no liability or responsibility to the 
original customer or any other party with respect to any liability, 
loss, or damage caused directly or indirectly by any 
Spectracom product, material, or software sold or provided by 
Spectracom, replacement parts or units, or services provided, 
including but not limited to any interruption of service, excess 
charges resulting from malfunctions of hardware or software, 
loss of business or anticipatory profits resulting from the use or 
operation of the Spectracom product or software, whatsoever 
or howsoever caused. In no event shall Spectracom be liable 
for any direct, indirect, special or consequential damages 
whether the claims are grounded in contract, tort (including 
negligence), or strict liability. 

EXTENDED WARRANTY COVERAGE  

Extended warranties can be purchased for additional periods 
beyond the standard five-year warranty for those products 
covered under five-year warranty. Contact Spectracom no later 
than the last year of the standard five-year warranty for 

www.spectracomcorp.com 

www.spectracom.fr 

 



extended coverage. 



Spectracom Corporation   
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1111 IntroductionIntroductionIntroductionIntroduction    

This manual contains information and warnings that must be understood and followed by the 
customer to ensure reliable operation and long service life. 
 

1.11.11.11.1 Safety PrecautionsSafety PrecautionsSafety PrecautionsSafety Precautions    

 

• Before switching on the unit, ensure that it is compatible with the local mains supply. 
(Refer to Installation). 

• The plug must be inserted into a socket with earth connection. The safety connection 
must not be broken by using an extension cord without earth conductor. 

• Before switching on the unit, if the unit is connected to measurement or control circuits, 
protective earth terminal(s) shall be connected to a protective conductor. 

• If measurement or control circuits are without earth-ground protection terminal(s), the 
mains plug shall be inserted before connections are made to measurement or control 
circuits. 

 

WARNING: If the protective conductor's path to ground is broken or 
defeated, the danger of electrical shock to the operator 
may be present. Never break the connection on purpose. 

  
 Before disconnecting the unit from the main power 

supply, always switch it off. Failure to do may cause 
damage that voids your Spectracom warranty. 

 

1.21.21.21.2 Safety during Adjustments, Maintenance, and RepaiSafety during Adjustments, Maintenance, and RepaiSafety during Adjustments, Maintenance, and RepaiSafety during Adjustments, Maintenance, and Repairrrr    

 
When the unit is connected to the power supply, it may be dangerous to touch the terminals and 
parts that may be exposed when opening covers or removing components (except for plug-in 
components). 
 
The unit must be disconnected from all power sources before carrying out any adjustments, 
replacements, maintenance, or repair. 
 
When it is unavoidable to open the unit for maintenance and repair, such operations should be 
carried out only by qualified personnel who are properly informed of the hazards involved. 
 
Only fuses with a suitable rating and of the specified type are to be used for replacement 
purposes. It is prohibited to use fuses that have been tampered with, or shorted fuse-holders. 
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WHENEVER IT IS LIKELY THAT PROTECTION HAS BEEN IMPAIRED, THE APPARATUS 
MUST BE SWITCHED OFF, DISCONNECTED, AND SECURED AGAINST ANY 
UNINTENDED OPERATION. 

1.31.31.31.3 InventoryInventoryInventoryInventory    

Before installing your Spectracom product, please verify that all material ordered has been 
received. If there is a discrepancy, please contact Spectracom Customer Service. Customer 
service is available by telephone at +33 (0) 1.64.53.39.80 (France), or +1.585.321.5800 (United 
States). Updated contacts information are available on web site, see “Support” page. 

 

CAUTION: Electronic equipment is sensitive to Electrostatic 
Discharge (ESD). Observe all applicable ESD 
precautions and safeguards when handling the 
Spectracom equipment. 

 
 

 
NOTE:  If equipment is returned to Spectracom, it must be shipped in its original packing 

material. Save all packaging material for this purpose. 

 

1.41.41.41.4 InspectionInspectionInspectionInspection    

Unpack the equipment and inspect it for damage. If any equipment has been damaged in 
transit, please contact Spectracom Customer Service.  Customer service is available by 
telephone at +33 (0) 1.64.53.39.80 (France), or +1.585.321.5800 (United States). Updated 
contacts information are available on web site, see “Support” page. 
 
The basic shipment comprises the following items: 

- The SSU 

- Two 48 VDC power plugs 

- This manual 

- CD-ROM containing SSUWIN (SSU Ethernet Local Manager Software). 

 
 

1.51.51.51.5 General DescriptionGeneral DescriptionGeneral DescriptionGeneral Description    

The main function of an SSU is to regenerate a synchronization signal from several possible 
reference sources and with a determined quality level. If all the sources disappear, the SSU 
maintains the synchronization rate with a built-in high-stability oscillator. Critical elements are 
backed up so that any failure on a module does not interrupt the clock distribution.  
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The SSU operating environment is currently based on 2048 kHz or 2048 kbit/s rates  
(E1 frames), with additional capabilities of synchronization and distribution in 10 MHz. 

The EPSILON SSU family has three types of clocks meeting the needs of the various 
performance levels as described in ITU-T and ETSI recommendations. The unit common to 
these three platforms is the SSU. The difference is in the performance of built-in oscillators. 

EPSILON PRC:   
Level 1 Reference Clock  
  
The PRC delivers a synchronization reference signal to all or part of a network. 
 
EPSILON STNe:   
Transit Node level-2 resynchronization clock (enhanced stability)   
 
The SSU-STNe is intended for transit nodes interfacing with other nodes. 
 
EPSILON STN:   
Transit Node level-2 resynchronization clock   
 
The SSU-STN is intended for transit nodes interfacing with other nodes. 
 
EPSILON SLN:   
Local Node level-2/3 resynchronization clock   
 
The SSU-SLN is intended for synchronization nodes interfacing directly with terminal 
equipment. 

Optionally, a GPS receiver provides long-term stability of the distributed frequency. 

 

 Accuracy in GPS Slaving Holdover Stability Holdover Short-term Stability 

PRC < ± 1x10-12 (24h) < ± 1x10-11 /day (Rb) < ± 1x10-11 /10 sec 
< ± 3x10-12 /100 sec 

STNe < ± 2x10-12 (24h) < ± 1x10-10 /day < ± 2x10-11 /10 sec 
STN < ± 2x10-12 (24h) < ± 3x10-10 /day < ± 1x10-10 /10 sec 
SLN < ± 2x10-11 (24h) < ± 1x10-9 /day < ± 1x10-10 /10 sec 

Table 1 - 1. Frequency Accuracy and Stability. 
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1.61.61.61.6 SubassembliesSubassembliesSubassembliesSubassemblies    

The breakdown into subassemblies ensures modularity sufficient to meet all customer needs 
and provide change possibilities. 

A unit comes in two configurations: with INPUT module and without INPUT module. The 
configuration is set at the restart of the MANAGEMENT module. That means that if you add an 
INPUT module while the SSU is running the reference signal path will not be modified. Instead, 
to make the INPUT module known, it is necessary to perform a reset on the MANAGEMENT 
module, unplugging and plugging back the module or short circuit the two pins at the front of the 
module (open the cover), or by SSUWIN software, activating the updated version of 
Management module (which is equivalent to a software reset of the module). 

Modules are hot plugged, without the need to cut mains supplies. Modules have their own 
power supply converters. 

 

Figure 1 - 1. SSU Modules. 

 

INPUT A and B Modules (2 locations):  
These accept synchronization inputs at 2048 kHz  (4 per module) and/or 2.048 Mbit/s (2 per 
module). One of the modules performs the function and the other ensures concurrently the 
redundancy. The SSU is fitted with 2 modules or 1 module (no redundancy) or no INPUT 
module if the input is direct to CLOCK module. 

CLOCK A and B Modules (2 locations):  
These are fitted, as chosen, with four versions of local oscillators in CLOCK-OCXO (STN), 
CLOCK-OCXO (STNe), CLOCK-OCXO (SLN), and CLOCK-Rubidium (PRC). The role of the 
module is to provide a stable clock from the synchronization inputs of the INPUT boards or from 
its own inputs (channel A at 2048 kHz/10 MHz and channel B at 2048 kHz) if INPUT boards are 
not installed. Each of the modules is fitted, optionally, with a GPS receiver. Two modules 
operating concurrently ensure redundancy. CLOCK modules exist in two versions (factory 
configuration): channel A is designed to receive either 10 MHz or 2048 kHz.  

DIST Modules (4 locations):  
These are available in three versions: DIST-2048 kHz, DIST-2048 kbit/s, DIST T/F (pps-tod-
10 MHz), distributing respectively eight 2048 kHz outputs, or eight 2048 kbit/s outputs, or two 

IN P U T C L O C K M A N A G E R D IS T

A
B

A
B

1 1
2

3
4
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10 MHz and two 1PPS outputs and two ToD outputs. Output amplifiers are backed up so as to 
deliver output signals even in case one of the amplifiers is failing, as the level, in this case, is 
only subjected to level decrease.  

MANAGEMENT Module (1 location):  
This manages configuration parameters and collects states, but is not essential for the SSU 
operation in "Running" mode. 
 

1.71.71.71.7 Maintenance and Supervision SoftwareMaintenance and Supervision SoftwareMaintenance and Supervision SoftwareMaintenance and Supervision Software    

The SSU apparatus is delivered accompanied by maintenance software SSUWIN running on 
PC in Windows environment. This PC is fitted with standard Ethernet RJ45 network interface 
and is connected direct to the Ethernet RJ45 connector of the SSU through a crossover cable or 
via IP network.  

In order to constitute a complete synchronization network, network supervision software 
EPSYNC MANAGER is supplied separately. This software is remote controlled from one (or 
more) PC / Windows supervision station(s) connected to the SSU via IP network. 

Functions of supervision with the SSU are described in the EPSYNC MANAGER user’s manual.  
Menus and functions of the SSUWIN software are included in the EPSYNC MANAGER 
software. 
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Figure 1 - 2. Front Panel - Connectors. 
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POWER  INPUTS 2048 kHz INPUTS/OUTPUTS 2048 kbit/s INPUTS REF INPUTS GPS 
POWER

-48V

-48V

  0 V
-48 V  

INPUTS 2048 kHz

H1

H2

H3

H4

 

INPUTS 2048 kbit/s

B2

B1

 

INPUTS REF

R1 R2  

INPUTS GPS

G1 G2  

Figure 1 - 3. Front Panel - Connectors (2). 

 

POWER  

 –48 V DC power supply backed-up input. Paths of both –48 V power supplies are 
separate up to powered modules. 

 
INPUTS 2048 kHz (H1, H2, H3, H4)  

 Inputs from synchronization clocks G.703 at 2048 kHz for INPUT boards (H1, H2, 
H3, H4) or for CLOCK boards (H1 and H2 on different pins) without INPUT board. 
 
Each connector powers concurrently both INPUT boards or both CLOCK boards. 
 
H1 is the direct input to CLOCK board (in its 2048 kHz version) and H2 is the direct 
input, in 2048 kHz, to CLOCK board (in both versions). See, in Appendix, H1 and 
H2 pin assignments in the case of an input to INPUT modules, or direct to CLOCK 
modules without INPUT board. 

 
INPUTS/OUTPUTS 2048 kbit/s (B1, B2) 

 Inputs from synchronization frames G.704 at 2048 kbit/s for INPUT boards. Each 
connector powers concurrently both INPUT boards. Input signals are duplicated 
through a line interface circuit and output from the same connector. 

 
INPUTS REF (R1, R2) 

 Inputs from synchronization clocks at 10 MHz for CLOCK boards (in their 10 MHz 
version), CLOCK A receiving signals from R1 and CLOCK B from R2. Only used if 
reference clock inputs are direct without INPUT board. 

 
INPUTS GPS (G1, G2) 

 Antenna inputs for GPS receivers on CLOCK boards. 
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OUTPUTS REMOTE CONTROL ALARMS EXTENSION 

O1 O2

O9 O10  

REMOTE CONTROL

RS232
ETHERNET  

N
U
R
G

ALARMS

U
R
G

A1 A2  

EXTENS.

 

Figure 1 - 4. Front Panel - Connectors (3). 

 
OUTPUTS (01 to 032) 

 Outputs from regenerated clocks (8 receptacles per DIST module) or frames G.704 
at 2048 kbit/s (8 receptacles per DIST module) or reference signals at 10 MHz, 
1PPS and ToD (6 receptacles per module). One line of connectors corresponds to 
one DIST Module with the same numbering. 

 
REMOTE CONTROL (RS232, ETHERNET RJ45) 

 Access via Ethernet Network to supervision and maintenance functions of the SSU 
and RS232 access for network-parameter configuration. 

 
ALARMS (A1, A2)  

 Outputs of alarm-indicating signals generated by MANAGEMENT board. 

 
EXTENSION  

 Access to an extension unit for DIST modules for a larger number of outputs. 

 
GROUND 

 

Casing grounding. 
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Figure 1 - 5. Front Panel – Warning Lights.  
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WARNING LIGHTS ON (R: RED OR G: GREEN OR Y: YELLOW)  

SEL (G) – DEF. (R) 

SEL

DEF.  

The LED indicates that module A or B is selected to perform the function (INPUT 
and CLOCK). The other module is available as a backup.  
 
The module is not in its normal operating condition, either for technical incident, or 
for lack of synchronization signal, or for search for tracking (CLOCK module). 

 
Input 2048 kHz – Input 2048 kbit/s (R)  

 Absence of signal on corresponding inputs, while they are declared as operating. 
With a 2048 kbit/s signal, a Loss Of Frame Synchronization Alarm is equivalent to 
a Loss Of Signal.  

 
2048 kHz SEL – 2048 kbit/s SEL (V) 

 Indicates the input that provides the module with synchronization reference. 

 
INP. 2048 kHz – INP. REF – INP. GPS (R) 

 Absence of signal on corresponding inputs, while they are declared as operating. 

 
SYNC. SOURCE (V)  

 Shows the source selected for synchronization. 

 
REMOTE CONTROL (V) 

 In RS232, lights up on traffic transiting via the corresponding connector. In 
Ethernet, lights up if the link is established. 

 
ALARMS (R) 

 Lights up on certain global criteria of the SSU status concerning the slaving and 
achieved distribution. Concurrently with LED states, alarm signals are activated on 
connectors A1 and A2. 

 
STATUS  (V) 

 Output in operation OK. 

 
2048 kHz – 2048 kbit/s – Freq – pps – ToD  (V) 

 Shows the type of DIST module. 
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1.101.101.101.10 Function Backups, ReliabilityFunction Backups, ReliabilityFunction Backups, ReliabilityFunction Backups, Reliability    

In order to ensure maximum availability, INPUT and CLOCK modules are backed up. 

Reference input signals are distributed over both INPUT modules, which work concurrently. 
Each INPUT module produces a different output for the two CLOCK modules. 

CLOCK modules work concurrently from the signals delivered by both INPUT boards. They 
each transmit their processed signals to distribution modules.  

If one INPUT module or CLOCK module fails, the second takes over from it automatically. 

Output buffers on DIST boards are backed up to keep supplying minimum signal level in the 
event that either of them fails. 

Once the SSU has been initialized, the MANAGEMENT module is not essential for the clock 
regeneration and distribution operation. Should this module fail, this does not cause the SSU 
base function to stop. 

1.111.111.111.11 HotHotHotHot----PluggingPluggingPluggingPlugging    

In order to ensure maximum availability, INPUT and CLOCK modules are backed up. 

When the SSU unit is powered on, it is possible to perform plugging and extractions of the 
various modules without stopping the synchronization distribution. 

NOTE: In order to ensure distribution continuity, the Master CLOCK must be forced to "Slave" 
mode using the maintenance PC before being removed. 
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2222 Technical FeaturesTechnical FeaturesTechnical FeaturesTechnical Features    

2.12.12.12.1 Dimensions and WeightDimensions and WeightDimensions and WeightDimensions and Weight    

- Width: 19" (441 mm), without bracket 
- Height:  9 U (365mm).   
- Depth:  277mm. 
- Weight:  < 15 kg. 

 

2.22.22.22.2 Operating EnvironmentOperating EnvironmentOperating EnvironmentOperating Environment    

- Operating temperature: 0 to 50°C. 
- Storage temperature: -40 to 85°C. 
- Relative humidity:  95 % non-condensing. 
- Electromagnetic compatibility:  in accordance with EN30386/EN55022/EN60950. 

2.32.32.32.3 Power SupplyPower SupplyPower SupplyPower Supply    

- Nominal DC input voltage:  -48 Volts. 
- Normal variation:  -40 to - 57 Volts. 
- Transitory variation:  -36 to - 72 Volts.  
 
- Two parallel input connectors. 
- Protection against polarity reversal. 
- 0 Volt DC input is not case grounded. 
- Every module protected by a PolySwitch fuse (automatically rearmed) 

2.42.42.42.4 Power Consumption on Power Consumption on Power Consumption on Power Consumption on ----48 VDC48 VDC48 VDC48 VDC    

- Nominal DC input voltage conditions:  -48 Volts DC. 
- INPUT Module:  0.12 A. 
- CLOCK (OCXO +GPS) Module:  0.22 A typical. 
- CLOCK (OCXO +GPS) Module:  0.3 A during start-up. 
- CLOCK (Rubidium +GPS) Module:  0.35 A typical. 
- CLOCK (Rubidium +GPS) Module:  0.7 A during start-up. 
- MANAGEMENT Module:  0.12 A. 
- DIST (No load):  0.06 A. 
- Maximum Total Power consumption:  < 150 W. 

2.52.52.52.5 2048204820482048    kkkkHz Synchronization InputHz Synchronization InputHz Synchronization InputHz Synchronization Input    

- Port type:  120 Ω symmetrical pair or 75 Ω coaxial pair  
(configuration achieved by strap presence in mating plug). 
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- Interface specifications according to G.703 ITU-T. 

- Attenuation of level in √f: 6 dB max at 2048 kHz. 
- One 9-pin SubD connector per input. 

2.62.62.62.6 2048204820482048    kbit/s Synchronization Inputkbit/s Synchronization Inputkbit/s Synchronization Inputkbit/s Synchronization Input    

- Port type: 120 Ω symmetrical pair or 75 Ω coaxial pair (configuration achieved by 
strap presence in mating plug). 

 
- Line coding:  HDB3. 
- Interface specifications according to G.703 ITU-T. 

- Attenuation of level in √f: 6 dB max at 2048 kHz. 
- Frame structure complying with G.704 and G.706 ITU-T. 
- CRC-4 operation mandatory. 
- Decoding of SSM messages according to definitions from ETSI EN 300 417-6-1 (§ 4.4 

and 4.5). 
- One 9-pin SubD connector per input. 

2.72.72.72.7 2048204820482048    kbit/s Synchronization Loopbackkbit/s Synchronization Loopbackkbit/s Synchronization Loopbackkbit/s Synchronization Loopback    

Loopback of G.704 2048 kbit/s link by extracting clock and data from input signal and 
recombining them without any data modification (including CRC, SSM). 

AIS Alarm is sent when a LOS (loss of signal) or LOF (loss of frame alignment) is detected 
on the incoming signal. 

- Port type:  120 Ω symmetrical pair or 75 Ω coaxial pair   
(configuration achieved by strap presence in mating plug). 

 
- Line coding:   HDB3. 
- Pulse mask according to G.703 ITU-T specifications. 

- Level 2.37 Volts (75 Ω) or 3 Volts (120 Ω) ± 10%. 
- Frame structure complying with G.704 and G.706 ITU-T. 

2.82.82.82.8  10 MHz Synchron 10 MHz Synchron 10 MHz Synchron 10 MHz Synchronization Inputsization Inputsization Inputsization Inputs    

Option, without Input Module: 
- Quantity:  2, one per CLOCK module. 
- Level:   > 0 dBm. 

- Input impedance:  50 Ω. 
- Jitter:  < 5 ns. 

- Connector:  female 50 Ω BNC. 
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2.92.92.92.9 GPS ReceptionGPS ReceptionGPS ReceptionGPS Reception    

Options 
- Quantity:  2, one per CLOCK module. 

- Connector:  Antenna female 50 Ω TNC. 
- Core:  GPS signal Input (L1). 
- Power supply to active antenna:  5V/75 mA max. 
- Fold Back protection:  the power supply is cut in the event of a short-

circuit in the antenna input. 

2.102.102.102.10 Timing Characteristics of SSUTiming Characteristics of SSUTiming Characteristics of SSUTiming Characteristics of SSU----PRCPRCPRCPRC    

- Type of local oscillator: Rubidium.  
- According to ETSI EN 300 462-1,2,3,5 or ITU-T G.811, G.812. 

2.10.1 Noise Generation in Locked Mode from GPS 

- According to §5.1 & 5.2 EN 300 462-6-1 fig. 1 & 2. 
- Loop filter type: Kalman predictive algorithm. 

2.10.2 1 pps/UTC Accuracy in GPS Mode 

- ± 50 ns (1 σ). 

2.10.3 Pull-in Range 

- Minimum pull-in range: ± 1.2x10-8. 

2.10.4 Noise Generation in Locked Mode from Ideal Reference 

- Wander according to §5.1 EN 300 462-6-1 fig. 1 & 2. 
- Jitter according to §5.2 EN 300 462-6-1. 

2.10.5 Holdover Mode 

- According to §9.2 EN 300 462-4-1. 
- Stability < ± 5x10-11/month. 
- Short term stability < ± 1x10-11/10 s. 
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2.10.6 Phase Noise Tolerance 

- According to §7 EN 300 462-4-1. 

2.10.7 Transfer Characteristics 

- According to §8 EN 300 462-4-1. 
- Loop filter type: Kalman predictive algorithm. 
- Time constant: 100-300-1000-3000-10000 s (nominal: 1000 s).  

2.10.8 Phase Response During Input Reference Switching 

- Phase response according to §6 EN 300 462-6-1. 

2.10.9 Phase Transient Due to CLOCK Module Switching 

- < 10 ns. 

2.112.112.112.11 TimingCharacteristics of SSUTimingCharacteristics of SSUTimingCharacteristics of SSUTimingCharacteristics of SSU----STNSTNSTNSTNeeee    

- Enhanced OCXO configuration. 
- Type of local oscillator: Double–oven crystal oscillator (OCXO Model 2). 
- According to ETSI EN 300 462-1,2,3,4 or ITU-T G.811, G.812. 

2.11.1 Pull-in Range 

- Minimum pull-in range: ± 2x10-8 mini. 

2.11.2 Noise Generation in Locked Mode from Ideal Reference 

- Wander according to §6.1 EN 300 462-4-1 fig. 1 & 2. 
- Jitter according to §6.3 EN 300 462-4-1. 

2.11.3 Holdover Mode 

- According to §9.2 EN 300 462-4-1. 
- Stability < ± 1x10-10/jour. 
- Short-term stability < ± 2x10-11/10 s. 
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2.11.4 Phase Noise Tolerance 

- According to §7 EN 300 462-4-1. 

2.11.5 Transfer Characteristics 

- According to §8 EN 300 462-4-1. 
- Loop filter type: Kalman predictive algorithm. 
- Time constant: 100-300-1000-3000-10000 s (nominal: 1000 s).  

2.11.6 Phase Response During Input Reference Switching 

- Phase response according to §9 EN 300 462-4-1. 

2.11.7 Phase Transient due to CLOCK Module Switching 

- < 10 ns. 

2.11.8 Noise Generation in GPS Locked Mode 

- According to §5.1 & 5.2 EN 300 462-6-1 fig. 1 & 2 (PRC performance). 
- Loop filter type: Kalman predictive algorithm. 
- Time constant: 100-300-1000-3000-10000 s (nominal: 1000 s).  

2.11.9 1 pps/UTC Accuracy in GPS Mode 

- ± 50 ns (1σ). 
 

2.122.122.122.12 Timing Characteristics of SSUTiming Characteristics of SSUTiming Characteristics of SSUTiming Characteristics of SSU----STNSTNSTNSTN    

- Standard OCXO configuration. 
- Type of local oscillator: Oven controlled crystal oscillator (OCXO Model 1). 
- According to ETSI EN 300 462-1,2,3,4 or ITU-T G.811, G.812. 

2.12.1 Pull-in Range 

- Minimum pull-in range: ± 3x10-7. 

2.12.2 Noise Generation in Locked Mode from Ideal Reference 

- Wander according to §6.1 EN 300 462-4-1 fig. 1 & 2. 
- Jitter according to §6.3 EN 300 462-4-1. 
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2.12.3 Holdover Mode 

- According to §9.2 EN 300 462-4-1. 
- Stability < ± 3x10-10/jour. 
- Short-term stability < ± 1x10-10/10 s. 

2.12.4 Phase Noise Tolerance 

- According to §7 EN 300 462-4-1. 

2.12.5 Transfer characteristic 

- According to §8 EN 300 462-4-1. 
- Loop filter type: Kalman predictive algorithm. 
- Time constant: 100-300-1000-3000-10000 s (nominal: 1000 s).  

2.12.6 Phase Response During Input Reference Switching 

- Phase response according to §9 EN 300 462-4-1. 

2.12.7 Phase Transient due to CLOCK Module Switching 

- < 10 ns. 

2.12.8 Noise Generation in GPS Locked Mode 

- According to §5.1 & 5.2 EN 300 462-6-1 fig. 1 & 2 (PRC performance). 
- Loop filter type: Kalman predictive algorithm. 
- Time constant: 100-300-1000-3000-10000 s (nominal: 1000 s).  

2.12.9 1 pps/UTC Accuracy in GPS Mode 

- ± 50 ns (1σ). 
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2.132.132.132.13 Timing Characteristics of SSUTiming Characteristics of SSUTiming Characteristics of SSUTiming Characteristics of SSU----SLNSLNSLNSLN    

- Optional OCXO configuration 
- Type of local oscillator: low cost crystal oscillator OCXO. 
- According to ETSI EN 300 462-1,2,3,7 or ITU-T G.811, G.812. 

2.13.1 Pull-in Range 

- Minimum pull-in range: ± 1x10-6. 

2.13.2 Noise Generation in Locked Mode from Ideal Reference 

- Wander according to §6.1 EN 300 462-7-1 fig. 1 & 2. 
- Jitter according to §6.3 EN 300 462-7-1. 

2.13.3 Holdover Mode 

- According to §9.2 EN 300 462-7-1. 
- Stability < ± 1x10-9/jour. 
- Short-term stability < ± 1x10-10/10 s 

2.13.4 Phase Noise Tolerance 

- According to §7 EN 300 462-7-1. 

2.13.5 Transfer Characteristic 

- According to §8 EN 300 462-7-1. 
- Loop filter type: Kalman predictive algorithm. 
- Time constant: 100-300-1000-3000-10000 s (nominal: 1000 s). 

2.13.6 Phase Response During Input Reference Switching 

- Phase response according to §9 EN 300 462-7-1. 

2.13.7 Phase Transient due to CLOCK Module Switching 

- < 10 ns. 
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2.13.8 Noise Generation in GPS Locked Mode 

- According to §5.1 & 5.2 EN 300 462-6-1 fig. 1 & 2 (PRC performance). 
- Loop filter type: Kalman predictive algorithm. 
- Time constant: 100-300-1000-3000-10000 s (nominal: 1000 s).  

2.13.9 1 pps/UTC Accuracy in GPS Mode 

- ± 100 ns (1 σ). 

2.142.142.142.14 Phase lockPhase lockPhase lockPhase lock----in at powerin at powerin at powerin at power----upupupup    

2.14.1 Warming-up 

- Warm-up time for the local oscillator before tracking search: 1000 s  for OCXO 
version and 3600 s for Rubidium version. 

- Then a fast tracking search bring the oscillator frequency close to the reference input 
signal frequency. 

2.14.2 Lock-in Time with 2048 kHz or 2048 kbit/s Signal 

- Output wander compatible with §6.1 EN 300 462-4-1 fig. 1 in: 1000 s max after 
warming-up. 

2.14.3 Lock-in Time with GPS Signal 

- Output wander compatible with §4.1 EN 300 462-4-1 fig. 1 in: 600 s max after 
warming-up. 

2.152.152.152.15 Input ReInput ReInput ReInput Reference Signal Quality Monitoringference Signal Quality Monitoringference Signal Quality Monitoringference Signal Quality Monitoring    

Parameters for MTIE/TDEV measurement: 

- Sampling period:   0.3 Hz. 
- Observation interval:   10 s, 100s, 1000 s. 
- Measurement period:   3 times the observation interval. 
- Measurement resolution:  1 ns. 
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2.162.162.162.16 2.0482.0482.0482.048    kHz OutputkHz OutputkHz OutputkHz Output    

- Number of DIST modules: 4 max. 
- Number of outputs: 8 per module. 
- One 9-pin SubD connector per output. 

- Port type:  120 Ω symmetrical pair or 75 Ω coaxial pair   
   (configuration achieved by strap presence in mating plug).  

 
- Interface specifications according to G.703 ITU-T - fig 20. 

- Level: 0.75 to 1.5 Volts (75 Ω) or 1.0 to 1.9 Volts (120 Ω). 

2.172.172.172.17 2.0482.0482.0482.048    kbit/s Outputkbit/s Outputkbit/s Outputkbit/s Output    

- Number of DIST modules:  4 max. 
- Number of outputs:   8 per module. 
- One 9-pin SubD connector per output. 

- Port type:  120 Ω symmetrical pair or 75 Ω coaxial pair   
  ( configuration achieved by strap presence in mating plug). 

 
- Line coding: HDB3. 
- Pulse mask according to G.703 ITU-T – fig 15 specifications. 

- Level 2.37 Volts (75 Ω) or 3 Volts (120 Ω) ± 10%. 
- Frame structure complying with G.704 and G.706 ITU-T. 
- Permanent CRC-4 operation. 
- Transmission of AIS alarm. 
- Coding of SSM messages according to definitions from ETSI EN 300 417-6-1 (§4.4 and 

4.5).  

2.182.182.182.18 1pps1pps1pps1pps, 10, 10, 10, 10    MHzMHzMHzMHz, ToD Outputs, ToD Outputs, ToD Outputs, ToD Outputs    

2.18.1 10 MHz 

- Number of outputs: 2. 
- One 9 pin SubD connector per output. 
- Waveform:   sine. 

- Level:   > 10 dBm over 50 Ω. 
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2.18.2 1PPS 

GPS Receiver required: 

- Number of outputs: 2. 
- One 9-pin SubD connector per output. 

- Level:    TTL over 50 Ω. 

- Pulse width:  100 µs ± 10 %. 
- Active rising edge:  < 20 ns.  

2.18.3 ToD 

GPS Receiver required: 

- Number of outputs: 2. 
- One 9-pin SubD connector per output. 
- Asynchronous RS232C, ASCII, 9600 bauds, 8 bits, 1 stop bit, odd parity. 
- Period:   1 s. 
- Content: Day/Month/Year/Hour/Minute/Second/Source. 
- User-programmable format. 
- Timing:   200 ms ± 100 ms after the 1 pps signal. 

2.192.192.192.19 Auxiliary Connector SignalsAuxiliary Connector SignalsAuxiliary Connector SignalsAuxiliary Connector Signals    

2.19.1 Alarm Connectors 

- Relay contact. 
- Maximum switching power:  30 W, 62.5 VA (resistive load). 
- Maximum switching voltage:  110 VDC, 125 VAC. 
- Maximum switching current:  1 A. 
- Urgent Alarm Connector:   9-pin SubD. 
- Non Urgent Alarm Connector:  9-pin SubD. 

2.19.2 Remote-control RJ45 

For SSU management: 

- Ethernet 802.3 10 Base T. Protocols: TCP/IP, SNMP, and FTP. 
- RJ45 connector. 
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2.19.3 Remote-control RS232 

For network parameters initialization only.  

- Asynchronous RS232C, 19200 bauds, 8 bits, 1 stop bit, no parity. 
- 9-pin SubD connector. 

2.19.4 Extension Connector 

- TTL level. 
- 25-pin SubD connector. 

2.202.202.202.20 Control PC for SSUWIN SoftwareControl PC for SSUWIN SoftwareControl PC for SSUWIN SoftwareControl PC for SSUWIN Software    

OS required: 
- Windows NT, 2000, XP.  
- Network management protocol: TCP/IP.  

Hardware configuration: 
- RAM mini:  256 MB. 
- Hard disk:  10 GB. 
- Ethernet interface: 10 Base T RJ45. 

 -  Display resolution:  1024x768 (SSUWIN) or 1280x1024 (EPSYNC Manager) 
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3333 Putting the SSU into ServicePutting the SSU into ServicePutting the SSU into ServicePutting the SSU into Service    

3.13.13.13.1 InstallationInstallationInstallationInstallation    

The apparatus can be used as such, or built installed in a rack.  In the latter case, locking 
brackets shall be secured to the SSU casing. Choose the arrangement: brackets on SSU front 
or brackets set back rearwards, depending on the type of rack. The space between brackets 
can follow either the Standard 19" Adaptation or the ETSI Adaptation. 

Leave free space of a few centimetres under the apparatus, in order to facilitate natural air flow 
from bottom to top of the SSU.  

Connecting cables for signals and power supply should be secured to locks provided for this 
purpose. 

3.23.23.23.2 Modules and Composition of an SSUModules and Composition of an SSUModules and Composition of an SSUModules and Composition of an SSU    

3.2.1 Composition of an SSU 

A SSU is composed of a Base Unit (Ref.: EPSSU) including the proper rack delivered 
equipped only with the MANAGEMENT module. Various modules are installed according 
to the ordered configuration.   

The SSU composition varies according to applications. 

3.2.2 INPUT Modules 

- EPSSU-INP:  four 2048 kHz inputs, two 2048 kbit/s inputs.  
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3.2.3 CLOCK Modules 

-EPSSU-Rb:  Rubidium Oscillator (PRC performance), two 2048 kHz 
inputs. 

 
-EPSSU-Rb-10 MHz:  Rubidium Oscillator (PRC performance), one 2048 kHz 

input, one 10 MHz input. 
 
-EPSSU-Rb-GPS:  Rubidium Oscillator (PRC performance), two 2048 kHz 

inputs, GPS equipped. 
 
-EPSSU-Rb-GPS-10 MHz:  Rubidium Oscillator (PRC performance), one 2048 kHz 

input,  one 10 MHz input, GPS equipped. 
 
-EPSSU-DO:  Double-oven OCXO Oscillator (STNe performance), two 

2048 kHz inputs. 
 
-EPSSU-DO-10 MHz:  Double-oven OCXO Oscillator (STNe performance), one 

2048 kHz input, one 10 MHz input. 
 
-EPSSU-DO-GPS:  Double-oven OCXO Oscillator (STNe performance), two 

2048 kHz inputs, GPS equipped. 
 
-EPSSU-DO-GPS-10 MHz:  Double-oven OCXO Oscillator (STNe performance), one 

2048 kHz input, one 10 MHz input, GPS equipped. 
 
-EPSSU-XO:  OCXO Oscillator (STN performance), two 2048 kHz 

inputs. 
 
-EPSSU-XO-10 MHz:  OCXO Oscillator (STN performance), one 2048 kHz input, 

one 10 MHz input. 
 
-EPSSU-XO-GPS:  OCXO Oscillator (STN performance), two 2048 kHz 

inputs, GPS equipped. 
 
-EPSSU-XO-GPS-10 MHz:  OCXO Oscillator (STN performance), one 2048 kHz input, 

one 10 MHz input, GPS equipped. 
 

3.2.4 DIST Modules 

- EPSSU-DIST-2MH:  Eight 2048 kHz outputs. 
- EPSSU-DIST-2MB:  Eight 2048 kbit/s outputs 
- EPSSU-DIST-10 MHz:  Two 10 MHz outputs, two 1PPS outputs, two ToD outputs. 
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3.33.33.33.3 Installation of ModInstallation of ModInstallation of ModInstallation of Modules into an SSUules into an SSUules into an SSUules into an SSU    

Installation of modules from left to right: 

- INPUT A:  slot 1 
- INPUT B:  slot 2 
- CLOCK A:  slot 3 
- CLOCK B:  slot 4 
- MANAGEMENT:  slot 5 
- DIST A:  slot 6 
- DIST B:  slot 7 
- DIST C:  slot 8 
- DIST D:  slot 9 

 
A polarization system consisting of a dowel and a notch in the board prevents the user from 
inserting boards into non-authorized slots. 

As regards input signals, INPUT boards support four 2048 kHz inputs and two 2048 kbit/s 
inputs. While CLOCK boards support one 2048 kHz or 10 MHz Ref input (factory choice) and 
another 2048 kHz input. For a limited number of inputs, INPUT boards are no longer essential. 
Moreover, if backup is not necessary, a single INPUT board is sufficient. In this case, prefer 
INPUT A board slot. 

The actual composition of the SSU is set at the start of the MANAGEMENT board. If the INPUT 
board is present, then the signal inputs are processed by the INPUT board. In this case the 10 
MHz Ref input is unavailable. If the INPUT board is not present, the signal inputs go directly to 
the CLOCK board. In this case and if the CLOCK board is a 10 MHz type board, one 2 MHz 
input and one 10 MHz Ref input are available. When modifying the composition, a reset of 
the MANAGEMENT board must be performed, so that the new configuration is initialized. 

As regards CLOCK boards, the minimum is one board. It will be backed up, if its redundancy is 
required. Every CLOCK board can accommodate its GPS receiver in the mezzanine form. The 
GPS module replaces or complements a Caesium-type PRS in PRC applications. In the case of 
a single CLOCK board, prefer CLOCK A slot. 

GPS receivers of CLOCK modules are connected to antenna feed through coaxial cable. In the 
case where the GPS is absent, the cable is secured to a dummy connector located on the 
backplane board. 

If CLOCK module oscillator is of Rubidium type, a plate improving the thermal scattering is 
screwed on the chassis frame, on the right of the board. 

For DISTRIBUTION boards, take care to use board guides aligned on backplane DIN41612 
connectors. Intermediate slots are intended for an extension (option) of the number of 
distributed signals. 
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From one to four DIST boards can be installed in the main chassis. These boards are of 
2048 kHz (clock signal G.703) or 2048 kbit/s (framed signal G.703/G.704) type. A version of 
distribution of 10 MHz, 1PPS, ToD sync also is available. The place is free in slots reserved for 
DIST boards.  

During a normal operation, automatic selections of backed-up boards give precedence to 
INPUT A board and CLOCK A board. 

3.43.43.43.4 Powering UpPowering UpPowering UpPowering Up    

Connect one or two power cables to the -48 V connector. Check the polarity of the power signal 
before connecting it (refer to the Appendix or to the front panel for the pin-out). 

After power-up, the MANAGEMENT module downloads and initializes the software of the 
INPUT and CLOCK modules. This may take a few minutes. A LED sequence starts flashing and 
then a default configuration is set: all inputs are enabled, highest priority is on H1 input, the 
INPUT module provides the reference signal to the CLOCK module. 

Check the LED status after the initialization sequence, and with no input connection. If the led is 
not ON, it is OFF. If a configuration has already been asked by the client before shipment, then 
the led status has been checked already. If you want to check it again, go on with the 
installation and reload with SSUWIN a standard configuration (all inputs declared enabled, 
priority 1..6, all automatic modes). Then check the led status according to the table.  

INPUT CLOCK MANAGEMENT DIST 

IN H1 ON IN H1 ON RS232  O1 ON 

IN H2 ON IN H2 ON ETHERNET  O2 ON 

IN H3 ON IN Ref    O3 ON 

IN H4 ON IN GPS ON   O4 ON 

IN B1 ON     O5 ON 

IN B2 ON     O6 ON 

SEL H1 ON SEL H1 ON URG ON O7 ON (*) 

SEL H2  SEL H2  NURG ON O8 ON (*) 

SEL H3  SEL Ref      

SEL H4  SEL GPS      

SEL B1      2048 kHz 

SEL B2  HOLDOVER ON   2048 kbit/s 

SEL ON (1/2) SEL ON (1/2)   Freq/pps/ToD 

ON (on 
corresponding 

type) 

DEF ON DEF ON DEF  DEF  

Table 3 - 1. LED Status. 

(*) The led is ON for 2048 kHz and 2048 kbit/s type only. On Freq/pps/ToD type, the led is OFF. 

On INPUT modules, the six red LEDs (H1 to B2) are ON, as no input is available. The SEL. LED 
for H1 link is ON. The red DEF. LED is also ON. Only one INPUT module is selected (led SEL 
ON). 
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On CLOCK modules, three red INP. LEDs are ON and the green SEL H1 SYNC. SOURCE LED 
is ON. The yellow HOLDOVER LED is ON. CLOCK A module SEL. LED alone is ON (CLOCK A 
is the master module). The red DEF. LED is ON.  

On OUTPUTS modules, green STATUS LEDs are ON, and the green module type LED is ON. 

If the SSU comes with no INPUT module, on 2048 kHz type CLOCK module, follow the above 
table. On 10 MHz type CLOCK module, the IN H1 led is OFF and the IN Ref is ON. 

3.53.53.53.5 Configure the SSUConfigure the SSUConfigure the SSUConfigure the SSU    

The next step to get the SSU working according to the actual set-up is to connect a PC running 
the SSUWIN software, and program the setup parameters. 

As the connection is of Ethernet type, the network parameters (IP adress) of the SSU must be 
compatible with network parameters of the PC running SSUWIN. See §6.2 describing the 
installation of the SSUWIN software. 

Once the PC can communicate (diagnostic "SNMP : OK" in the screen bottom status bar), the 
minimum configuration parameter to set relates to the source of the reference signal on INPUT 
and CLOCK module. Leaving all the selection modes on "Automatic", all the "Link Declaration" 
on "On", enables all the input accesses. The SSU is able to track a reference signal and 
distribute output signals. 

While making connection set-up at the input of the SSU, keep in mind that the selection 
algorithm of input channel applies a confirmation delay of 10s before selecting a lower priority 
input and 1000s before going back to a higher priority input. 

3.63.63.63.6 Synchronizing with 2048Synchronizing with 2048Synchronizing with 2048Synchronizing with 2048    kHz or 10kHz or 10kHz or 10kHz or 10    MHz signal with no INPUT MHz signal with no INPUT MHz signal with no INPUT MHz signal with no INPUT 

ModuleModuleModuleModule    

CLOCK modules come in two versions (factory configured): 

- Channel A Input working at 10 MHz, and Channel B Input at 2048 kHz. 
- Channel A Input working at 2048 kHz, and Channel B Input at 2048 kHz. 

3.6.1 Synchronizing with a 10 MHz signal and a 2048 kHz signal 

The 10 MHz reference signal is labelled REF on the Front Panel Alarm Leds and Sync Source 
Leds. But the processing chanel in the CLOCK board is the A chanel which works also in the 
2048 kHz signal version.So the configuration and status fields in the SSUWin menus are the 
same for the 10 MHz input or 2048 kHz input on the A chanel.  
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Connect a 10 MHz reference (REF label) signal to R1 connector for CLOCK A module, and 
another one to R2 connector for CLOCK B module. Connect a 2048 kHz to H2 connector for 
both CLOCK A and CLOCK B modules. 

Make sure that the reference frequency is within the pull-in range (paragraphs 2.12.1 or 2.13.1 
or 2.10.3).  

The corresponding INP. REF and INPUT B/H2 LEDs are cleared.  

After a synchronizing period (a few tens of minutes), DEF. LEDs are cleared. 

SEL. LEDs show the selected reference input. 

3.6.2 Synchronizing with Two 2048 kHz signals 

Connect two 2048 kHz reference signals to H1 and H2 connectors. 

Make sure that the reference frequency is within the pull-in range.  

The corresponding INPUT A/H1 or INPUT B/H2 LEDs are cleared.  

After a synchronizing period (a few tens of minutes), DEF. LEDs are cleared. 

SEL. LEDs show the selected reference input. 

3.73.73.73.7 SySySySynchronizing with 2048nchronizing with 2048nchronizing with 2048nchronizing with 2048    kHz or 2048kHz or 2048kHz or 2048kHz or 2048    kbit/s Signal through kbit/s Signal through kbit/s Signal through kbit/s Signal through 

INPUT ModuleINPUT ModuleINPUT ModuleINPUT Module    

Connect at least one 2048 kHz reference signal to a H1 to H4 connector and/or a 2048 kbit/s 
signal to B1 to B2 connector. 

Be sure that the reference frequency is within the pull-in range (paragraphs 2.12.1 or 2.13.1 or 
2.10.3).  

The corresponding INP. 2048 LEDs are cleared.  

After a synchronizing period, DEF. LEDs are cleared. 

SEL. LEDs show the selected reference input. 
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3.83.83.83.8 Synchronizing with GPSSynchronizing with GPSSynchronizing with GPSSynchronizing with GPS    

The GPS antenna should be connected to G1 for GPS of CLOCK A or G2 connector for GPS of 
CLOCK B. 

The corresponding INP. GPS LED is cleared after initialization of the module (about 10 
minutes).  

After a synchronizing period, DEF. LEDs are cleared. 

SEL. LEDs show the selected reference input. 
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4444 OperationOperationOperationOperation    

4.14.14.14.1 General Information on Operating FunctionsGeneral Information on Operating FunctionsGeneral Information on Operating FunctionsGeneral Information on Operating Functions    

4.1.1 Management of Operating Functions 

The MANAGEMENT module manages the operation run on INPUT, CLOCK and DIST modules, 
that is initialization, software loading, configuration parameters, status and alarms feedback, 
and also performance measurements. 

Nevertheless, once they have been initialized, these modules are able to perform their 
synchronization hold task in respect for the recommendations. 

Moreover, through the MANAGEMENT board, operators gain access to operating functions via 
REMOTE CONTROL Ethernet connection, locally with SSUWIN software or via the supervision 
network with EPSYNC software. 

4.1.2 Remote Control Ethernet 

4.1.2.1 Local Control 

Thanks to this access, the SSU is controlled in local mode by an operator, from a PC fitted with 
SSUWIN software under Windows NT/2000/XP. Configurations are modifiable, and states and 
alarms can be viewed locally. 

Configuration modification operations can be carried out during the normal run of the SSU 
OPERATION. 

This is SSUWIN software, which we will refer to in all accesses from control PC during start-up, 
setup, and status display operations. 

4.1.2.2 Control by Supervision Network 

When a certain number of SSUs make up a complete network of synchronization distribution, 
these units can be connected as a network of IP type through RJ45 Ethernet connector. 
EPSYNC software under Windows 2000 is then used to monitor the distribution consistency and 
quality. 

Remotely, the configuration of SSUs is programmed, SSU states are displayed, and the quality 
of links is continuously observed. A centralized database gathers all the information relating to 
the network and equipment and also that concerning operators.  Consult EPSYNC software 
documentation. 
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4.1.3 Configuration of the SSU 

On SSU power-up, a configuration stored on MANAGEMENT board is implemented in each of 
the modules. Likewise, if a module alone has just been hot plugged, MANAGEMENT module 
initializes it with its configuration. 

It is also possible to program entirely an SSU from a configuration file sent by SSUWIN 
software. 

4.1.4 Nominal Operation of the SSU 

In nominal operation, the SSU reacts autonomously according to default criteria or criteria 
operator-programmable through MANAGEMENT board. 

Operations managed by the very modules concern: 

- Automatic selection of input links by INPUT board (or CLOCK board, if the SSU 
configuration SSU is without INPUT board); 

- Automatic selection of the operational INPUT board ("Running/Spare") (decision by 
Master CLOCK module); 

- Automatic selection of the operational CLOCK board ("Master/Slave" choice) (mutual 
decision by CLOCK modules); 

- Slaving algorithm for the local oscillator, which works with programmable slaving 
constants; 

- Quality measurement for the six 2048 kHz and 2048 kbit/s input links that are 
continuously characterized by a measurement of MTIE and TDEV made on 3 points of 
the template. The measurement result is compared to a threshold and comes into 
selection criteria for synchronization links. Thresholds are fixed. 

4.1.5 Maintenance Functions of the SSU 

Certain functions normally performed automatically by SSU modules can be forced through 
SSUWIN software run on a PC. 

Operator-controllable operations are: 

- Selection of input links on INPUT board (choice from six), 
- Selection of the operational INPUT board ("Running/Spare" choice), 
- Selection of the operational CLOCK board ("Master/Slave" choice), 
- Selection of the input link on CLOCK board (INPUT A/ INPUT B/ GPS choice). 

 

The operator has thus the possibility of replacing a faulty module or analyzing a special problem 
without hindering the normal SSU operation. 
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4.1.6 Status of the Elements 

The status of the various elements in SSU and also the measurements made are accessible by 
SSUWIN software. 

They relate to the selection of the reference synchronization link at the input, selection of 
"Running" INPUT board, selection of "Master" CLOCK board. Fault detection's on each board is 
used to monitor the right operation SSU operation. 

4.1.7 Alarms 

Two alarms (Urgent and Non-Urgent) are generated depending on the states of modules 
making up the SSU and configurations performed. Relevant LEDs are visible on 
MANAGEMENT module. 

Non-Urgent alarms are generated when a parameter goes out of operating limits but have no 
effect on SSU performance.  

Urgent alarms are generated when the SSU detects a defective module, or when the generated 
signal has lost its synchronizing reference. 

Refer to section 6.3 for the Urgent and Non Urgent alarm origins. 

Concurrently with the display, both alarms are available in the form of two contact relays; the 
one being open and the other closed in the absence of an alarm and reversely in the presence 
of an alarm. 

Refer to the Appendix for the pin assignment of the front panel alarm connectors. 

4.24.24.24.2 Configuration ParametersConfiguration ParametersConfiguration ParametersConfiguration Parameters    

4.2.1 Network Parameters 

- Initialization by a text terminal connected to RS232 Remote Control connector. 

4.2.2 INPUT Module 

4.2.2.1 Links Synchronizing INP Module 

For each of the 6 input links (1 to 4 : 2048 kHz links, 5 to 6 : 2048 kbit/s links): 

- Taking into account or not the input link (1 to 6),   
(Default: All the links are taken into account) 

- Input selection mode (Automatic or Forced),   
(Default: automatic selection) 
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- Module selection mode (Automatic or Forced),   
(Default: automatic selection) 

- Priority of the link (1 to 6), (Default: 1, 2, 3, 4, 5, 6) 

4.2.2.2 MTIE / TDEV measurements 

- Define or not the utilization of MTIE measurements for selecting the synchronizing link, 
(Default: non-utilization) 

- Define or not the utilization of TDEV measurements for selecting the synchronizing link, 
(Default: non-utilization) 

- MTIE template parameterization in µs:   
(Fixed: 10 s = 1000 ns, 100 s = 2000 ns, 1000 s = 5000 ns),  

- TDEV template parameterization in ns:   
(Fixed: 10 s = 34 ns, 100 s = 170 ns, 1000 s = 170 ns),  

4.2.2.3 SSM thresholds 

- For links 5 and 6, define the taking into account or not of SSM content for selecting the 
link and the taking-into-account threshold. 

- Taking the SSM into account: used or not used for each of the 2 links, (Default: not 
used) 

- Minimum quality threshold per link: (0010, 0100, 1000, 1011, 1111), (Default: 1111) with, 
in descending order of quality: 

0010:  PRC quality, 
0100:  Transit Node quality, 
1000:  Local Node quality, 
1011:  SEC quality, 
1111:  "Do not use" quality. 

The link is considered useable if its detected SSM message is of greater  or equal quality than 
the threshold.  

4.2.3 CLOCK Module 

4.2.3.1 CLOCK Module Inputs 

The parameters depend on presence or not of INPUT boards.  

- Input from INPUT boards or from Direct Accesses on Front Panel. 
 

In the case of Direct Accesses on Front Panel, channel A is factory configured in 2048 kHz (H1 
input) or in 10 MHz (Ref input). Channel B is always in 2048 kHz (H2 input).  

In the case of INPUT board Accesses, channel A and B come respectively from INPUT A an B 
boards in 2048 kHz (H2 input).  
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4.2.3.2 CLOCK Module Selection 

For maintenance purpose, the Master/Slave CLOCK mode can be automatic or manually forced 
on CLOCK A or CLOCK B module (Default: Automatic).  

4.2.3.3 Links Synchronizing CLOCK Module 

For the 3 incoming links: (link 1: 2048 kHz or 10 MHz, link 2: 2048 kHz, link 3: GPS). 

- Taking into account or not of links (1 to 3), (Default: all the links are active). 
- Section mode: automatic or In A forced or In B forced or GPS forced, (Default: 

Automatic). 
- Priority of each of the links (1 to 3), (Default: 1, 2, 3). 

4.2.3.4 Issued 2048 kbit/s Frame Content 

- Activation of the issued SSM: always enabled. 

4.2.3.5 MTIE / TDEV Measurement 

- Define or not the utilization of MTIE measurements for selecting the synchronizing link, 
(Default: non-utilization). 

- Define or not the utilization of TDEV measurements for selecting the synchronizing link, 
(Default: non-utilization). 

- MTIE template parameterization in µs:   
(fixed: 10 s = 1000 ns, 100 s = 2000 ns, 1000 s = 5000 ns). 

- TDEV template parameterization in ns:   
(fixed: 10 s = 34 ns, 100 s = 170 ns, 1000 s = 170 ns). 

4.2.3.6 Oscillator  

Oscillator parameters are stored in non-volatile memory, in factory. They describe the 
characteristics essential to slave and follow up the setpoint (ageing). Only the type of oscillator 
(Rubidium/OCXO) is recalled on SSUWIN software screen. 

4.2.3.7 Slaving Time Constant 

- Choice of the slaving time constant: 100/300/1000/3000/10000s (Default: 1000s). 

4.2.3.8 GPS 

- The GPS antenna position must be fixed. 
- Receiver operating mode: automatic position calculation but for fixed set. Once the 

position has been calculated, data are extracted from a single satellite. 
- Correction of the antenna delay (Default: 0 ns). 
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4.2.4 DIST Modules 

The SSU distribution function is provided with 4 slots reserved for inserting DIST modules. 
Modules can be of different types: 2048 kHz, 2048 kbit/s, T/F. Configuring is performed in 
factory and is non-programmable. 

For a special maintenance mode: 

- Selection mode for the synchronization source (Automatic, CLOCK A, CLOCK B), 
(Default: Automatic). 

4.34.34.34.3 Operating StatesOperating StatesOperating StatesOperating States    

Two kinds of states are available at a module: static states related to operator-performed 
configurations, and dynamic states related to behaviour of SSU modules. 

SSUWIN software is able to retrieve the status of SSU configuration parameters according to 
the description in the above paragraph. 

Dynamic states are described per module. They are displayed by the LEDs on SSU front panel, 
against each of the modules concerned. 

4.3.1 INP modules 

- Faulty module (yes/no). The module is faulty if none of the declared synchronization 
signals is present, or if the synchronization signal is not delivered to CLOCK modules; 

- Operation ("Running" or "Spare"). The choice is made by Master CLOCK board, and 
displayed on "sel" LED; 

- Detection of presence of declared links (OK/Alarm). On 2048 kHz inputs, it is presence 
detection for clocks leading edges at nominal frequency. In 2048 kbit/s, the detection of 
frame locking is added; 

- Number of the selected synchronizing link (one from 6) according to the algorithm 
described on page 4-10. 

4.3.2 CLOCK Modules 

- Module faulty (yes/no). The module is faulty if none of the declared synchronization 
signals is present, if the slaving to this signal is not yet achieved, or if the signal is not 
delivered to DIST board. In the case of a "Slave" CLOCK board, a misalignment of the 
signal distributed on "Master" board signal also contributes to setting to fault; 

- Operating mode (Master, Slave), displayed on "Sel" LED; 
- Detection of presence of declared links (OK or alarm). LEDs concern A and B inputs, 

10 MHz Reference inputs, GPS module (locked or fault); 
- Selected synchronizing link (Input A, Input B, GPS) ; 
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- Oscillator status (In progress of slaving, Slaved, Holdover). 

4.3.3 DIST Modules 

- Faulty module (yes/no), 
- Type of DIST module (2 MHz, 2 Mbit/s, T/F), 
- Selected signal source (CLOCK A or CLOCK B), 
- Output signal states for the 8 channels (1: OK/NOK … 8 : OK/NOK). 

4.3.4 Management Module 

Available states at the Management module are as follows: 

-  General status of the board (OK/Fault), 
-  Urgent Alarm status (OK/Fault), 
-  Non-Urgent Alarm status (OK/Fault), 

4.44.44.44.4 Description of the SSU FunctionsDescription of the SSU FunctionsDescription of the SSU FunctionsDescription of the SSU Functions    

4.4.1 Automatic Selection of Input Links 

The algorithm follows the same principles on INPUT board and on CLOCK board. 

Selecting the synchronizing input link is either automatic according to parameterizable criteria, 
or forced. The selection algorithm is operational in automatic mode. 

The management system for INP module makes the following works on synchronizing links: 

1 - Scanning of links that are declared "enable", "disable" links cannot be selected. 

2 - For each of the available links, check of the signal presence. If the link is "not present", it 
is declared unusable, an alarm is generated, but the scanning remains active. 

3 - For each of the available and present links, a quality test (MTIE and TDEV) is 
conducted, if authorized. If the test result remains within its boundaries, the link is 
declared useable. 

4 - For both 2048 kbit/s links only, a test on SSM message is conducted if authorized. The 
link is declared useable if the SSM quality code read is higher than or equal to the 
programmed threshold. 

5 - Each of the links has a configurable priority level that is used to decide between useable 
links. 
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Sanction: 

The synchronizing link accepted at a given instant is that for which points 1, 2, 3, 4 are correct 
and that has the highest declared priority. 

The decision law reacts according to the processing order for parameters used in the following 
order: Forcing, Declaration, Presence, Performance, SSM, Priority. 

A few special cases shall be noted. 

If a 2 Mbit/s link includes a SSM message of higher quality level and is put into competition with 
another 2 Mbit/s link of lower quality level but higher than the minimum required threshold, the 
latter can be selected if its priority is higher. 

If certain links are declared but do not include SSM (2 MHz, 1st-generation GPS or network), 
and are put into competition with links including a SSM, a first selection is performed on 2 Mbit/s 
links with SSM, and then useable links are put again into competition with links without SSM 
according to their priority. 

Criteria of selection according to MTIE/TDEV quality measures are only valid if a current slaving 
assures a stable enough reference signal. The decision to change of link because of 
measurement results is only after stabilization and confirmation of 1000 s (typical values). 

4.4.1.1 Switching Management for Synchronizing Downlinks 

Switching from the nominal synchronizing link to another link with lower priority is only 
performed if the nominal link is declared out of tolerance for a minimum (10s by default). 

Switching is then performed to the immediately lower priority link, if this link is correct. The link 
momentarily defective remains qualified. 

If the nominal link is out of tolerance for less than 10 seconds, the selection stays on it. 

4.4.1.2 Switching Management  for Synchronizing Uplinks 

All the incoming synchronizing links are continuously qualified. If the defective link becomes 
correct again, its qualification continues. If after a minimum time (1000s by default), the link is 
still correct, it takes again its place in the table of links available for synchronization, moreover, if 
this link has priority higher than that of the current link, changeover to this link is performed. 

4.4.1.3 Selection of the Synchronizing Link in Forced Mode 

This mode is used by the operator in charge of synchronizing the communication network, when 
he/she detects choices of synchronizing-link switching that are not judicious and that may result 
in uncontrolled drifts. This is the typical case of an SSU synchronizing with another SSU that 
itself is in "Holdover" mode. 

In this mode, this is the operator, who manages, through the PC/SSUWIN, the switching 
between synchronizing links from the information he/she is provided with. The automatism 
existing at input links is disabled and replaced with operator controls designating the link used 
as the synchronization link. 
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4.4.2 Selection of the Operational INPUT Board 

This choice is made by CLOCK module, from the configuration, INPUT board states, and 
measurement made on CLOCK board input links. 

The choice in automatic mode depends on operator-performed parameterizations, priorities: INP 
or GPS. 

For 2 INP boards, choices of INPUT board used depend on: 

- The clock validation signal transmitted by INPUT boards, 
- The status of each of CLOCK board inputs (presence detection, MTIE/TDEV), 
- The priority assigned to INPUT board signals and to GPS channel. 

When all the states are correct, the selection is performed on the module with the highest 
priority. 

If the INP board selected as the synchronizing link has a defective status, switching to the 
second INP board is only performed if the defective status appears for a minimum time (10s 
fault). The return to priority board is only performed if the status of this board is continuously 
correct for a minimum time (1000s by default). 

4.4.3  Selection of the Master CLOCK Board 

4.4.3.1 Master/Slave Switching of CLOCK Modules 

On SSU start-up, choosing "Master" module is performed by default automatically and results, 
on completion of the putting into operational condition phase, in the choice of CLOCK A module. 

During operation, the choice can remain automatic or can be forced (either A Master and B 
Slave, or A Slave and B Master) the operator through the maintenance PC or the supervision 
station. 

4.4.3.2 Selection of Master CLOCK Module in Automatic Mode 

In automatic mode, the signal used by distribution (DIST) boards is chosen by a switching 
implemented on these boards. The selection control is performed on both CLOCK boards 
simultaneously by a logic module (H/W) for rapidity reasons. This module uses the signals from 
the other CLOCK module.  

As a general rule, if both CLOCK modules are slaved and faultless, CLOCK A module is set as 
"Master". If the "Master" module is faulty, the selection switches to the other CLOCK module 
instantaneously, provided that this one is not itself faulty. The return to normal slaving conditions 
on module A results in switching immediately again to module A in "Master" mode. 
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4.4.3.3 Selection of Master CLOCK Module in Forced Mode 

For maintenance reasons, the user can use CLOCK B module in the place of module A. The 
operator forces then the selection, using PC/SSUWIN. When the maintenance operation is 
completed on module A, the operator restores the automatic selection mode.  

4.4.4 Slaving of the Local Oscillator 

4.4.4.1 Slaving Algorithm 

The slaving is of this type: slaving in phase with local oscillator on reference signal whose phase 
is taken at arbitrary value at slaving beginning. The filtering used in the loop is of self-adaptive 
type: this is Kalman filtering. 

At the algorithm start, a first rapid step enables the oscillator to come close to the reference 
frequency ("fast mode"). Then, the slaving time constant is set to its nominal value for a precise 
slaving step ("accurate mode"). 

It is possible to modify the slaving constants during operation. The nominal constant meeting 
ETSI standards for SSUs is the 1000 s constant. For reasons of compatibility with the quality of 
signal transmission lines, it is possible to change this slaving constant, knowing that too long 
constants will not enable certain oscillator drifts to be taken up, which are due to exterior 
conditions, of temperature for example. 

4.4.4.2 Management of Special Events 

If the signal at the input is lost for a short time (less than 10s), the slaving is stopped in 
"Holdover" mode, and then resumed in its accurate phase after phase calculation restabilization. 

In a case of a longer or multiple interrupt, the slaving resumes in fast mode. 

On switching of the synchronizing input link, the slaving is stopped momentarily in "Holdover" 
mode and resumes in accurate mode.  

4.4.4.3 Holdover Mode 

This SSU operating mode is a degraded mode that occurs when the SSU is in Auto Select 
mode and is no longer provided with any valid synchronizing link.  

In this mode, CLOCK module oscillators are standalone and operate on the last frequency 
slaving step applied before the changeover to Holdover. In this mode, incoming synchronizing 
links keep being qualified so as to be able to resume slavings when one of them becomes valid 
again. 

Through an operator's configuration command, Holdover mode can be forced for maintenance 
reasons.  
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4.4.5 MTIE/TDEV Measurements 

4.4.5.1 Measurement Conditions 

Measurements are made on the six input links simultaneously on INPUT board and both INP 
inputs on CLOCK board. The measurement reference is the slaved local oscillator. 

Three points of each of the MTIE and TDEV templates are examined: 10, 100, 1000 s. A result 
is provided on demand with SSUWin software. 

The measurement is effective and the results available only when local "Master" oscillator has 
changed over to a locked status. 

It shall be noted that depending on the tracking time constant, the measurement at 1000 s loses 
its value since the oscillator is likely to "follow" the reference signal. The phase difference 
measured between the two signals will thus be decreased with respect to its actual value. 

4.4.5.2 Measurement Parameters 

The measurement is used to compare the quality of links with a given template. By default, 
these values represent the template of the figure in ETSI recommendation concerning the 
tolerance for inputs of synchronization with the wander. 

4.54.54.54.5 Management of the SSM MessageManagement of the SSM MessageManagement of the SSM MessageManagement of the SSM Message    

4.5.1 Utilization of the SSM message 

The SSM message is designed to help right synchronization distribution, considering the quality 
level of references (PRC, Transit node, Local node, unknown). It is only available on 2048 kbit/s 
synchronization frames. 

The message is composed of 4 bits located in Sa bits (1 from 5: Sa4 to Sa8) of 2 Mbit/s frame 
G.704. Currently, only channel Sa4 is used. 

SSM code Quality Level 

0010 PRC (highest) 
0100 SSUT Transit clock 
1000 SSUL Local clock 
1011 SEC SDH Equipment clock 
1111 DNU do not use clock (timing loop situation) or SSM usage disabled 
0000 Unknown 

Table 4 - 1. Utilization of the SSM message. 

The frame of the reference input signal is analyzed and its SSM retrieved on the Sa4 bit. 
According to the SSU status and to this message, a decision of input selection is made. On the 
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distribution side, an output SSM message constituted according to the slaving operating status 
is integrated into the distributed 2048 kbit/s output frame. 

4.5.2 Review of Received SSM Messages 

The received SSM indicates the quality of the synchronization source. It is used to select the 
input link used as the reference. 

If an input link is enabled and present, and if its SSM messages shows a quality level higher or 
equal to the programmed minimum threshold, it can be selected as a reference link. The priority 
level decides in case there are two links available. 

If an input link is enabled and present, but if its SSM message shows a quality level below the 
programmed minimum threshold, an alarm is activated on that link and it cannot be selected as 
a reference link. 

The operator has the choice to include or not the SSM into the link alarm and selection criteria.  

The SSM corresponding to the selected link is transmitted to CLOCK board for constitution of 
the issued SSM. The SSM transmitted to CLOCK board is that of the selected incoming 2 Mbit/s 
link or SSM=0000 (quality unknown) if this is a link of clock at 2048 kHz. 

N.B. The Unknown code should not be used in the new synchronisation networks. If the 
threshold is set to "Unknown", only the "Unknown" SSM link will be accepted as a selectable 
link.  

4.5.3 Constitution of the Distributed SSM Message 

This are the rules applied for constituting the SSM contained in distributed 2 Mbit/s signal (into 
the Sa4 frame bit). 

- If the distributed signal is coming from a 2048 kbit/s reference signal to which the output 
is slaved, the signal SSM is copied as such; 

- If the distributed signal is coming from a 2048 kHz reference signal to which the output is 
slaved, quality code SSM "Transit Node" is issued; 

- When the signal comes from a GPS reference or a 10 MHz signal, the SSM assumes 
the value of PRC quality; 

- During transient "Warm-Up" phases, the SSM assumes the value of "Do Not 
Use" quality; 

- During Holdover phase or "Tracking Search" phase, the SSM assumes "Transit Node" 
quality level if the oscillator is Rubidium, and "Unknown" after 24 hours. If other types of 
oscillator are used (OCXO), the SSM assumes "Local Node" quality level, and 
"Unknown" after an hour. 
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4.64.64.64.6  MANAGEMENT OF 2048 MANAGEMENT OF 2048 MANAGEMENT OF 2048 MANAGEMENT OF 2048    kbit/s FRAMES G.704kbit/s FRAMES G.704kbit/s FRAMES G.704kbit/s FRAMES G.704    

4.6.1 Received Frames 

If the Frame Alignment detection is in a locked state, the clock extracted from the data stream is 
used as a possible synchronizing source. 

The SSM message is decoded at this level and is used, if necessary, for selecting the reference 
link.  

4.6.2 Transmitted Frames 

The received data stream is looped back to the same B1 or B2 connector. As a physical loop-
back, the frame content is unchanged. If no signal is present at the input, nothing is transmitted 
back. 

4.6.3 Output Distributed Frames 

The Output distributed frames are built with the Frame Alignment pattern with CRC4 and an idle 
content (0B in hexadecimal) on the other slots. The SSM message is inserted into the odd 
framing pattern slots, in the Sa4 bit. 

4.74.74.74.7 HotHotHotHot----Plugging/ExPlugging/ExPlugging/ExPlugging/Extractiontractiontractiontraction    

During maintenance operations, boards can be hot extracted with minimum disturbance to 
output signal. 

If the INPUT module processing the input signal is extracted, CLOCK board changes over to 
"Holdover" mode for a few seconds, the time to switch to the other INPUT board. However, it is 
preferable, with SSUWIN software (on control PC) to force the selection mode for INPUT 
module to "Forced B Input" before performing extraction. Restore automatic mode after 
extraction. 

CAUTION:  As the Master CLOCK board provides the synchronization signal to the 
distribution, it must NOT be extracted abruptly. A command from SSUWIN 
software (on PC) shall previously force it to "Slave" mode, and the other module 
to "Master", and thus discharges it from its function. Else, the distributed signal is 
likely to be subjected to cuts of several periods.  
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5555 SSUWIN Maintenance SoftwareSSUWIN Maintenance SoftwareSSUWIN Maintenance SoftwareSSUWIN Maintenance Software    

5.15.15.15.1 Operating EnvironmentOperating EnvironmentOperating EnvironmentOperating Environment    

The SSUWIN software is designed to dialogue with the SSU, locally from a PC connected via 
an Ethernet 10 Base T link, with crossed RJ45 cable. 

It is then possible to reread an SSU configuration, modify it, and follow up the operating status 
of modules with respect to input links. 

The software is executable on PC fitted with Windows OS (NT, 2000, XP) and Ethernet 
10 Base T-RJ45 interface. 

The PC will communicate with the SSU if IP addresses declared on each side are compatible, 
i.e. they belong to the same sub-network. So, check that the combination of the IP address of 
the PC and SSU and the corresponding mask gives the same sub-network address. 

5.25.25.25.2 Installation AND STARTInstallation AND STARTInstallation AND STARTInstallation AND START----UPUPUPUP    

5.2.1 PC Connection with the SSU 

The PC shall have an Ethernet 10 Base T interface. 

To connect the PC directly with the SSU, use a crossed RJ45 cable of good quality (shielded 
cable is preferable). 

It is also possible to connect the SSU to a local area network through a straight RJ45 cable, 
provided that IP addresses are programmed adequately on the SSU and on the PC. 

 

Figure 5 - 1. EPSILON SSU / PC or Terminal Connections 
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The SSU/PC serial RS232 cable is a straight 9-point cable. 

The RS232 serial link is necessary to program the IP parameters of the SSU (see paragraph 
5.2.3 and 5.2.4). 

The RJ 45 link is necessary to control the SSU from a PC running the SSUWIN software. 

5.2.2 Installation of SSUWIN Software in PC 

Before upgrading SSUWIN, it is advised to uninstall the previous version under Windows OS. 

The software is available on SSUWIN CD-ROM. 

Insert the CD (autorun mode) or run SETUP.EXE program and follow instructions for a standard 
installation. 

By default, EPSYNC Manager is installed in c:\Programfiles\Tekelec Systemes\SSUWin. 

Start then SSUWIN program through the shortcut. 

5.2.3 Default SSU IP Addresses 

When outgoing factory, the SSU is configured with an IP address x.y.z.w that was used for 
testing and mask 255.255.255.0. It recognizes an address at sub-network address x.y.z.0. 

For PC / SSU dialogue to be possible, two methods can be used:  

- either the PC IP address is changed to match the SSU IP address with Windows tools 
(configuration Panel -> Network -> TCP/IP -> Properties), giving it an address of the same sub-
network (same first 3 numbers and different fourth number). 
- or the SSU IP address is changed with its utility through the RS232 serial link in order to 
dialogue directly with the PC. This address should form part of the same sub-network as the 
PC. The procedure is detailed in the paragraph below.  

In both cases, the SSU IP address must be typed in the PC (SSUWIN) with <Setup>Network> 
menu of SSUWIN. 

5.2.4 Changing IP Network and Configuration Paramaters in the SSU 

5.2.4.1 Implementation of the SSU Configuration 

When you want to change IP addresses in the SSU and its correspondents, a special utility 
contained in the SSU provides the means. 

In order to activate this utility, connect a VT100 compatible terminal (U.S. characters) or a PC 
emulating a terminal (with Hyperterminal program for example), to RS232 serial link located on 
SSU front panel on the left of the RJ45. 
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On the SSU side, a connection program continuously active will recognize the TTY serial 
connection and a login prompt will be displayed on the terminal screen. 

Answer: 

>login : ssu 

>password : manager 

The programming utility for IP addresses starts automatically. 

The matter is then to answer the questions use to change SSU IP addresses and allowed 
destination addresses. 

Several text menus are to be browsed to establish the various network addressees the SSU 
must know. 

Keys to be used are as follows: 

- Up and down arrows to select the operation to be performed. 
- Tabulation to change over from a field to be validated to another. 
- Return to <OK> or entry field to validate the operation. 
- Return to <Cancel> to exit the current menu. 
- Space to tick lines during multiple selections. 
- Uppercase and lower alphanumeric characters (case sensitive) and "_" allowed, for 

entry of network and machine names. 

 

5.2.4.2 Menu: "Configuring the SSU" 

Select the operation with up and down arrows. Return to <OK> to start the operation. Return to 
<Cancel> to exit the program. 

NOTE: Changes will only be taken into account when "Applying modifications" operation is 
executed. 

 

5.2.4.2.1 Menu: "Setting the SSU Parameters" 

Enter the name of the machine seen by the network (see allowed characters, above). 

Enter the date and local time.  

5.2.4.2.2 Menu: "Configuring the Network Access" 

IP addresses and names in the network will be entered in these menus. 
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5.2.4.2.3 Menu: "IP Parameters Setting" 

This menu edits the SSU IP address, corresponding mask, subnetwork address, broadcast 
address and default gateway address. 

In the case of a direct SSU connection with a PC, mandatory fields are the IP address, mask 
and subnetwork address. 

In the case of a connection via network and if the PC is not on the same sub-network, the 
default gateway address is essential to access the PC (unless the path is shown in the routing 
table below). 

5.2.4.2.4 Menu: "DNS Configuration" 

Optional utilization of the function, if the network is equipped consequently. 

In such a case, enter the address of the name server provided by the network administrator. 

Parameters not used in direct connection with PC.  

5.2.4.2.5 Menu: "Host Table Definition" 

Optional. 

This table is used to establish the correspondence between mnemonics and addresses of 
machines in the network. It facilitates the establishment of the routing table by handling the 
mnemonics of routers / gateways in the place of their digital addresses. 

5.2.4.2.6 Menu : "Defining the Network Name Table" 

Optional. 

This table is used to establish the correspondence between mnemonics and network 
addresses. It facilitates the establishment of the routing table by handling the mnemonics of 
networks in the place of their digital addresses. 

5.2.4.2.7 Menu: "Defining the Routing Table" 

Optional. 

This table is used to establish the first transit address of packets according to their final 
destination. 

The network to be reached is entered first, and then the address of the router located on the 
same network as the SSU enabling it to be accessed. The "metric" parameter evaluates the 
route in number of hops (0 means undetermined). The type of router should be set to "passive" 
in the case of a simple router without routing daemon, to "active" if routing protocol daemons 
are activated, to "external" if the router is connected to Internet. In case of doubt, it is preferable 
to program the mode to "passive". 
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5.2.4.2.8 Menu: "Doing a Ping"  

After applying changes, it is possible to test a connection with a ping at an address to be 
entered. 

5.2.4.2.9 Menu : "Determining the Network Path" 

Display transit nodes to reach the entered destination address. 

5.2.4.2.10 Menu: Active Routing Table 

Summarize the addresses of intermediate gateways enabling final-destination addresses to be 
reached. 

5.2.4.2.11 Menu: "List the Modifications" 

Before applying changes, it is possible to make sure of them by rereading the items. 

5.2.4.2.12 Menu: "Applying the Modifications" 

Must be done before performing a ping and before exiting the program. 

5.2.4.2.13 Menu: "Cancel the Modifications" 

Run this function in case of error in the modifications. 

5.2.4.2.14 Menu: "Retrieving Previous Config" 

After applying the modifications, in case of error, it is possible to go back to the original 
parameters. 
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5.35.35.35.3  <File> Menu <File> Menu <File> Menu <File> Menu    

 

 

Figure 5 - 2. File Menu. 
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File menu allows accesses to following functions: 

- Software upgrading. 
- Status refreshing F5. 
- Configuration saving. 
- Configuration loading. 

5.3.1 Saving or Loading the Configuration 

SSU configurations are stored in the PC under ".cfg" extension files. 

When you want to save an SSU configuration you are editing in <Configuration> menu, execute 
"Save Configuration" command. Choose the file name. 

When you want to retrieve a saved configuration, execute "Load Configuration" command. You 
can then edit it and program the SSU with this configuration in <Configuration> menu. 

When you quit SSUWIN program, and in order to prevent the current configuration from being 
lost, the program proposes the operator to save the configuration in a file. 

5.3.2 Status Refreshing "F5"  

Available only in "View" menu, typing "F5" key produces a refresh of the detailed SSU status 
displayed in this menu. It only accelerates the regular scanning of the status (about every 
minute). 

In the "Setup" menu, "F5" key has no effect. Instead, upload the parameters of the SSU by 
clickink on the "Reading SSU parameters" button. 

5.3.3 Software Upgrade  

A new software version of any ssu module (Input, Clock, Management) is upgraded with the 
"Software Upgrade" function of the "File" menu. 

Upgrading a software is done in several steps. 

When available for upgrade, the new release is copied in any chosen directory of the PC 
running SSUWin. Its extension is always ".tgz". 

Then, the SSU operator can decide to download the files into the SSU. Downloading does not 
interrupt the ongoing synchronization of the SSU. The release file is just stored in the 
Management Module waiting to be activated.  The activation will take place at the next reset of 
the board to be upgraded. 
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Figure 5 - 3. Release Download  Menu. 

 

Choose the "Release Download" menu. The files directory will be selected in the "Select files to 
download" window. Then click on the files to be downloaded and pass them into the right 
windown with the ">>" button. To delete a file from the list, click on the "<<" button. 

To start downloading, click on the "Download Files" button. Follow the status in the rightmost 
window. 
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Figure 5 - 4. Release Activation Menu. 

 

Choose the "Release Activation" menu to activate the downloaded version. Actually a new 
version replaces a running version when the card is reset. The Management Module reload the 
new version and start the software. 

You must be carefull not to reset the Master Clock Module for a release. Instead, force the 
Master Clock to Slave in the "Set Up" menu, make the "Release Activation" operation and 
program back the Master/Slave Mode to "Automatic" for a normal state. 

In this "Release Activation" screen, the "Activate" button starts the reset of the corresponding 
module. The led on the right give an indication about the safety of the procedure. A green light 
means "go". A red light means "not safe". On the right of the led, the current module operation 
give the reason why it may or may not be safe to activate the reset. 

In a fully equipped SSU, the Input B Module (Spare) and the Clock B Module (Slave) and the 
Management Module should show a green light and can be reset (one after the other). Once 
this release is done, use the "Set Up>Clock" menu to program the Master/Slave mode to Master 
for the Clock B module and Slave for the Clock A module. And use the "Set Up>Input" menu to 
program the Module Selection Mode to "Input B running, Input A Spare".  Click on the "SSU 
Configuration" button to program the SSU. 

Then going back to the "Release Activation", wait for the green light to be on and click the 
"Activate" button for Input A and Clock A modules (one after the other). 



EPSILON SSU   Spectracom Corporation  
 

User’s Manual 5-10 

5.45.45.45.4 <Setup> MENU<Setup> MENU<Setup> MENU<Setup> MENU    

 

Figure 5 - 5. Setup Menu. 

Setup menu provide accesses to the following submenus: 

- Setup Network. 
- Setup Input. 
- Setup Clock. 
- Setup GPS. 
- Setup Distribution. 

5.4.1 Functions of the Menu 

All the SSU operating parameters can be changed from this menu. They concern the internal 
operating modes of the modules and the SSU behaviour with respect to synchronization links. 

Dialogues with SSU are performed in the form of SNMP exchanges or FTP files. A status bar 
located at screen bottom provides diagnostics on current exchanges. 

NOTE: The configuration of modules displayed on the screen is a configuration currently being 
edited, which is not sent to the SSU from modification.  

The displayed configuration is actually sent to the SSU by clicking "Configure SSU" button at 
screen bottom. 
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It is possible to retrieve a configuration to be edited either through <File> menu, from a saved 
configuration, or by clicking on "Reading SSU States" button from the connected SSU. In the 
latter case, configuration parameters and states are fed back simultaneously. Key F5 is not 
active. 

At program start, a default configuration is loaded, but not that of the connected SSU. 

5.4.2  <Setup >Network> Submenu 

 

Figure 5 - 6. Network Menu. 

Network menu provides accesses to the following parameter: 

- IP Address. 
- SSU Parameters. 
- SSU Configuration. 

In order to access SSU, it is first indispensable to enter its IP address. Once the IP address has 
been entered (press <Enter>), a connection is attempted with SNMP protocol. The connection is 
displayed in the lower left corner of the screen (SNMP OK or ERR or NOT SSU in case the 
equipment responding at this address is not an SSU). 

Pressing "Reading SSU parameters" button upload the configuration parameters of the SSU to 
be edited. 

Pressing "SSU Configuration" button transmits the module configuration information to the SSU. 
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5.4.3  <Setup >Input> Submenu 
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Figure 5 - 7. Input Setup Menu. 

Input menu provides accesses to the following parameters: 

- Module Selection. 
- Input Link Selection. 
- Link Declaration. 
- Link Priority. 
- MTIE/TDEV selection criteria. 
- MTIE/TDEV Template. 
- SSM Threshold Selection criteria. 

INPUT board detects the available reference synchronization links, selects one to provide it to 
CLOCK boards. 

Programmed choices concern the input module receiving the synchronization links and 
characterizing them. 

Click on the drop down box with the left button to modify the parameters. 

"Module Selection" frame defines the selection mode for the active INPUT board (A or B): 

- automatically (A has priority if everything operates correctly), 
- INPUT A board forcing or INPUT B board forcing (on the occasion of maintenance 

operation for example). 

The function is to used in particular to replace or to software upgrade INPUT A board. 
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"Input Module Current Status " recalls which INPUT provides the synchronization reference to 
CLOCK boards. "Running" board provides the signal and "Spare" board is available in case the 
first is failing. By default, the A board is in "Running". 

"Input Selection " frame defines the selection mode for synchronization links: 
- Automatically according to presence, priority, and MTIE/TDEV and SSM criteria declared 

in "INPUT board configuration parameters" table;  
- Forcing for each of the links (4 links at 2048 kHz, and 2 at 2048 kbit/s). 

Among configuration parameters, it is necessary to edit: 

- "Link Declaration " column indicating that the input link is part of the choices possible in 
the selection of the synchronizing link in "On" case; if the box is at "Off", the link is not 
envisaged as the synchronization source; 

- "Link Priority" indicates the priority level of each of the links, 1 being the highest priority. 
Priorities are exclusive, as each of the links has a priority different from the others; 

- "Selection MTIE/TDEV" columns indicate whether MTIE/TDEV measurements made on 
input links are taken into account to select the synchronizing link; 

- "SSM Active" column indicates whether the SSM code carried by the frame of 
2048 kbit/s input links is a selection criterion for links; 

- "Template MTIE/TDEV" frame gives the values of comparison threshold for taking into 
account input links from declared links if the relevant boxes in "MTIE/TDEV 
measurements" columns are at "YES". Values are not programmable for the moment;  

- "SSM Threshold" frame gives the minimum SSM code to be observed for the 2048 kbit/s 
link to be selectable; 
 

NOTE: The frame G.704 uses the bit Sa4 of odd IT0 Time Slot to convey the SSM message. It 
is frozen at Sa4 for the moment and is not programmable. 
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5.4.4  <Setup >Clock> Submenu 

 

 

Figure 5 - 8. Clock Setup Menu. 

The Clock menu provides accesses to the following parameters: 
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- Master/Slave Selection Mode. 
- Synchronization Link Selection Mode. 
- Link Declaration. 
- MTIE/TDEV Measurements. 
- MTIE/TDEV Template. 
- Tracking Time Constant. 

CLOCK board receives the reference synchronization link used to synchronize its internal 
oscillator. 

"Mode (Master/Slave)" field is used to program the CLOCK board selection mode providing the 
clock to be distributed: 

- Automatic (with priority on CLOCK A board), 
- "Master Forced" (so, B Slave) or "Slave Forced " (so, B Master). 

The function is to used in particular to replace or to software upgrade CLOCK A board. 

"Synchronizing Link Selection" frame programs the selection between INPUT A, INPUT B, GPS: 
- Automatic (depending on alarms, priorities and MTIE/TDEV measures), 
- "Forced INPUT A" or INPUT B or GPS. 

In normal operation, leave in "automatic". 

Among configuration parameters, it is necessary to edit: 

- "Link Declaration " column indicating that the input link is part of the choices possible in 
selecting the synchronizing link; 

- "Link Priority" indicates the priority level of each of the links. Priorities are exclusive, as 
each of the links has a priority different from the others, 1 being the highest priority; 

- Selection MTIE/TDEV" columns indicate whether MTIE/TDEV measurements made on 
input links are taken into account to select the synchronizing link; 

- "Template MTIE/TDEV" frame gives the values of comparison threshold for taking into 
account input links from the selected ones; 

- "Oscillator Parameter" frame is used to program the slaving time constant for the local 
oscillator. And recalls the type of oscillator available on CLOCK boards. 
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5.4.5  <Setup >GPS> Submenu 

 

Figure 5 - 9. GPS Setup Menu. 

GPS menu provides accesses to the following parameters: 

- Value of the correction of antenna propagation delay in ns. 

A single parameter is to be programmed: this is a deviation expressed in ns to be applied a 
priori to slaving calculations in order to compensate for the signal delay between antenna and 
SSU input.  

Used when the absolute phase of output signal is important (1PPS signal). 
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5.4.6 <Setup >Distribution> Submenu 

 

Figure 5 - 10. Distribution Setup Menu. 

Distribution menu provides accesses to the following parameters: 

- Sync Source Selection Mode. 

DISTRIBUTION board makes 8 copies of the 2048 kHz or 2048 kbit/s output signals provided 
by a CLOCK board. Then, output signals are distributed to SubD connectors on front panel. 

A parameter is used, in special maintenance case, to force the synchronization source selection 
for the DISTRIBUTION board. 

In normal case of operation, leave the operation in "Automatic". "CLOCK A Forced " or "CLOCK 
B Forced " states are to be used for special tests but they do not assure that the Master CLOCK 
board provides the synchronization signal.  
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5.55.55.55.5 <View> MENU<View> MENU<View> MENU<View> MENU    

 

Figure 5 - 11. View SSU Front Panel Menu. 

The View menu provides access to the following information: 

- SSU Front Panel. 
- Status Input. 
- Status Clock. 
- Status GPS. 
- Status Distribution. 
- Synoptical. 
- Software versions. 

5.5.1 Functions of the <View> Menu 

In this menu, the SSU remote image and current status are displayed with refresh time of one 
minute.  

Immediate refresh may be required by pressing key F5 (rereading SSU states). 

5.5.2 <View >SSU Front Panel> Submenu 

The actual status of LEDs is displayed on this image of the SSU. 
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5.5.3 <View >Detailed Status> Submenu 

 

Figure 5 - 12. View Detailed Status Menu. 

View status menu provides accesses to the following informations: 

- View Status INPUT. 
- View Status CLOCK. 
- View Status DISTRIBUTION. 
- View Status GPS. 

For each module, the reread SSU configuration is displayed, and also the states, selections and 
measurement results in the form of tables. 

For each module, the "Module Status" indicator takes up the indication on front panel "Default" 
LED. When it reads OK on every module, the synchronization on a reference signal and the 
distribution are performed. 
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5.5.3.1 <View >Detailed Status>INPUT> Submenu 

 

 Figure 5 - 13. View Input Status Submenu. 

The indicators below recall the board configuration parameters. 

- "Module Selection Mode" indicates whether "Running/Spare" selection between INPUT 
A or B module is automatic or forced; 

- "Module Operation" indicates that INPUT module is effectively in "Running" or 
"Spare" status; 

- "Synchronizing Link" indicates the synchronizing link source: H1/H2/H3/H4/B1/B2; 

- "Synchronizing Link Selection Mode" indicates automatic or forced selection mode for 
INPUT module input links. 

The table groups together the states and parameters concerning each link: input alarm, priority, 
taking into account or not the MTIE and TDEV and SSM for the automatic link selection. 

Moreover, by clicking on down arrow in MTIE/TDEV boxes, a table of current measurement 
results is displayed. 

The SSM value displayed in the B1 and B2 columns are the minimum SSM threshold qualifying 
a link for selection when the function is activated. 

Status take up the alarm and link selection information available on front-panel LEDs. 
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5.5.3.2 <View >Status>CLOCK> Submenu 

 

 Figure 5 - 14. View Clock Status Submenu. 

The indicators below recall the board configuration parameters. 

- "Module Selection Mode" indicates whether "Master/Slave" selection between CLOCK A 
or B module is automatic or forced; 

- "Module Operation" indicates that CLOCK module is effectively in "Master" or 
"Slave" status; 

- "Synchronizing Link" indicates the synchronizing link source: INPUT A/H1 or INPUT 
B/H2 or GPS; 

- "Synchronizing Link Selection Mode" indicates automatic or forced selection mode for 
CLOCK module input links; 

- "H1 Frequency": in the case of an SSU configuration without INPUT board, indicates the 
type of direct input used by channel A 2048 kHz by H1 or 10 MHz by R1 (or R2) on the 
CLOCK module; 

- "Oscillator Type": indicates whether the local oscillator is a Standard Quartz oscillator 
(OCXO model 1) or Double-oven quartz oscillator (OCXO model 2) or Rubidium type; 

- "Oscillator Tracking Status" indicates the slaving status: "Holdover" or "Tracking Search" 
or "Locked".  

-  "Oscillator Control Voltage" gives the current control voltage of the local oscillator. The 
value lies between 0 and 10 Volts. At the beginning of the life of oscillators, we should 
read around 2.5 Volts for the Rubidium model and 3.6 Volts for the Quartz model. The 
value varies according to the input link reference frequency  and the aging of the 
oscillator. 
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- "Tracking Time Constant" gives the programmed time constant in the Tracking phase 
loop.  

The table groups together the states and parameters concerning each link: input alarm, priority, 
taking into account or not the MTIE or TDEV for the automatic link selection. 

Moreover, by clicking on down arrow in MTIE/TDEV boxes, a table of current measurement 
results is displayed. 

States take up the alarm and link selection information available on front-panel LEDs. 

 

5.5.3.3 <View >Status>DISTRIBUTION> Submenu 

 

Figure 5 - 15. View Distribution Status Submenu. 

The indicators below recall the board configuration parameters. 

- "Module Type" indicates the type of Distribution board: 2048 kHz or 2048 kbit/s or T/F; 

- "Synchro Source" indicates which of CLOCK A or B modules provides the signal to be 
distributed, normally, the synchro source is the "Master" module, unless forcing is 
requested. 

The table shows the status concerning each output signal. 
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5.5.3.4 <View >Status>GPS> Submenu 

 

Figure 5 - 16. View GPS Status Submenu. 

The "GPS Clock Information" provide the decoded information of SSU position co-ordinates and 
information about GPS receiver status : 

- "GPS Receiver " gives the global status of the GPS reception. "Locked" means that 
reception is good on at least 4 satellites. "Unlocked" means that a problem of reception 
exists, either with the antenna connection or the number of decoded satellites; 

- "Antenna" indicates the status of the connection with the GPS module; 

- "GPS serial link" relates to the link between the CLOCK module and the GPS module. 
When no GPS module is present, no GPS information is displayed. So, "GPS serial link" 
is always read at OK. 

- "PPS" is the reference for clock synchronization. It should stay at "Present". Otherwise 
an alarm on the CLOCK module may be triggered. 

- "Number of Satellites " gives the number of satellites decoded by the receiver providing 
the Signal/noise ratio is high enough for decoding the channel. Four satellites is a 
minimum to lock the receiver;  
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5.5.4 <View >Synoptical> Submenu 

 

Figure 5 - 17. View Synoptic Submenu. 

 

The block diagram shows the path of signals inside the SSU, from synchronization reference 
inputs to distributed signals. The boards selected or not, in alarm or not, are marked according 
to the colour code displayed on the same screen. 
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5.5.5 <View >Software versions> Submenu 

 

Figure 5 - 18. View Software Versions Submenu. 

All the hardware and software versions are listed in these frames, per module of the connected 
SSU. 

The first number is the version currently running. The second number (in parenthesis) is the 
waiting version which will be activated at the next reset of the module. When the versions are 
up-to-date, the two numbers are identical. 

When upgrading a module (Hardware, Firmare and Software alltogether), the new version is 
first downloaded into the MANAGEMENT module and its number will appear in the second 
number. 

Only the recognized module in an SSU are displayed. 

The Upgrade menu is accessible with "File>Software Upgrade" 
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5.5.6 <View >Monitoring Status> Submenu 

 

Figure 5 - 19. View Monitoring Status Submenu. 

 

With SSUWin, it is still possible to check the parameters set by the management software 
EPSYNC Manager. No programming is achieved on these parameters with SSUWin. 

The first display shows the destination addresses of the alarms messages (SNMP traps) and 
performance monitoring. With the "EPSYNC Manager" network management system, only the 
Destination Address N°1 is  used. The second address can be modified by any MIB Browser 
(specialized for SNMP protocol dialog), and where a parallel network management system 
would be able to process the traps. 

Then the "Monitoring Status" frame shows if the monitoring is enabled or disabled and the 
period of monitoring in minutes. 

The "Software Flags" is an indicator of FTP transfer status of files between the PC and the SSU. 
The normal state is 0. The "Software release download" flag goes to 1 during the "Release 
Download" operation (Input or Clock or Management module). When the file has been 
acknowledged by the SSU, the flag reset. The "SSU Configuration" flag goes to 1 when the 
Configuration Parameters are sent down to an SSU. The meaning of a permanent "1" flag would 
be a failure of the Management module to process the sent files. 
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6666 MaintenanceMaintenanceMaintenanceMaintenance    

6.16.16.16.1 Updating the Software VersionUpdating the Software VersionUpdating the Software VersionUpdating the Software Version    

6.1.1 Definition of the Software Versions 

The type software architecture of a CLOCK or INPUT module in the SSU is represented in the 
following form: 

 

Figure 6 - 1. Software versions. 

Hot-loaded software is stored in Management board in Compact Flash. This board also contains 
the operating system OS (Linux) and the onboard application. 

The software is modifiable remotely through network access. 

DIST board software is contained in its own microcontroller and is started in an autonomous 
way. It is not modifiable by downloading. 

A software version follows the representation below: 

Software version Major Minor Micro 

V X Y Z 

Table 6 - 1. Software versions. 

In which, the change in indices follows this logic: 

X: When new functionalities are implemented, which are not compatible with the previous 
versions. 

Y: New functionalities are introduced and are compatible with the previous versions and/or 
correction of bugs. 

Z: Correction of bugs only. 

 

Configuration 
parameters 

Onboard 
software 

Boot  
software 

FPGA 
program 

Hot loading Factory loading 
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The downloading update function is available for Management, Input and Clock modules. The 
update includes "On board software" and "FPGA program". A downloadable software is a file 
with a .tgz extension. 

In the menus, the running version is displayed in a straight manner, and the waiting version is 
diplayed in parenthesis on the right of the running version. When up-to-date, the running version 
is the same as the waiting version. 

6.1.2 Updating software in nominal operation 

Updating software is performed from SSUWin or EPSYNC Manager software. Refer to section 
5.3.3 for the procedure description. 

The updating concerns one board after the other. The procedure performs a restart of the board 
concerned by the updating. It is therefore essential, first, to force the synchronization path on 
boards not affected by the updating. To do so, use "CLOCK A Slave" forcing or reversely, and 
then "Input A Running/ Input B Spare" forcing, or reversely. On completion of updating 
command, a board restart is performed, and then forced modes are set back to automatic for 
the operation. 

6.26.26.26.2 Oscillator ControlOscillator ControlOscillator ControlOscillator Control    

One good indicator of the oscillator behavior and of the tracking status is the value of the control 
voltage of the oscillator which is available in the View>Detailed Status>Clock screen. When the 
input reference link is traced to a PRC, or a GPS signal, the control voltage is the image of the 
ageing of the oscillator. 

Abnormal values are stable 0 volts or stable high voltage (>9 Volts). In that case, the tracking 
algorithm cannot bring the oscillator to the reference frequency. The reason can be either a bad 
oscillator or a bad reference. A locked GPS receiver is a good reference. If while tracking a GPS 
reference, the oscillator voltage is still in a shifted position, it should be changed. 

6.36.36.36.3 Urgent AND NONUrgent AND NONUrgent AND NONUrgent AND NON----Urgent alarmsUrgent alarmsUrgent alarmsUrgent alarms    

Alarms are grouped together at the level of the MANAGEMENT board, in two forms. Non 
Urgent ALarms and Urgent ALarms. The meaning of these alarms is as follows: 

- AL NUR: means that one of the backed-up items is unavailable, but that the general 
operating condition of the signal generation chain is correct, 

- AL UR: means that the service quality is no longer assured and that the operation is 
degraded. An action is imperative. 
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These alarms are visible on the SSU front panel (red LEDs) and available in the form of dry 
loops ALARMS front panel connectors. 

 

Types of Alarm Items concerned AL NUR AL UR 

Disappearance of a backed-up module or 
Def led activated on a backed-up working 
module 

INPUT, CLOCK X  

Disappearance of a module DIST DIST modules  X 
Disappearance of the last module or Def led 
activated on the last working module 

INPUT, CLOCK modules  X 

Fault of a declared link Link declared on INPUT 
(from 6) and CLOCK(GPS) 

X  

Fault of all declared links Link declared on INPUT 
(from 6) and CLOCK(GPS) 

 X 

Changeover of a CLOCK module to 
"Holdover" mode 

CLOCK A or B module  X 

Table 6 - 2. Urgent/non-urgent alarms. 

 

Consult the pin assignment of ALARMS connectors in order to control the initiation of audible 
alarm for example. 

6.46.46.46.4 Analysis of Internal Warning LightsAnalysis of Internal Warning LightsAnalysis of Internal Warning LightsAnalysis of Internal Warning Lights    

When the Def front panel led is activated on the CLOCK module, internal warning lights give 
additional indications on noticed malfunctions. 

Power Supply/Management Alarm 
(DS4) 

Red Absence of 5/12 Volts converted voltage or 
problem with PC or terminal operation 

Slaved Oscillator Alarm (DS6) Red Oscillator not slaved to input link (algorithm in 
"Tracking search" state) 

Slaved Phase Shifter Alarm (DS7) Red Slave CLOCK module phase shifter not slaved 
to Master CLOCK module signal. Activated 
sometimes during transitional operations. 

Output Signal Alarm  (DS8) Red Absence of CLOCK module output signal 

Table 6 - 3. Internal warning lights. 

 

Any of these internal alarms activates the general "Def" led. 
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6.56.56.56.5 TroubleshootingTroubleshootingTroubleshootingTroubleshooting    

Use a PC provided with SSUWIN software to perform diagnostics. 

Symptoms can be analysed with front panel leds. Every DEF leds at the lower part of the front 
panel should be OFF when the configuration is correct and the oscillator tracking achieved. If 
not, go through the following examination.    

6.5.1 INPUT Board 

When fault warning light (DEF) is ON while input signals are connected: 

- Check that connected links are declared "active" in INPUT configuration menu; 

- If yes, then check that alarm LEDs corresponding to input links declared active are OFF; 

- If an input LED is ON, then the signal is absent or at a wrong frequency, or does not 
meet the required MTIE/TDEV quality conditions, (cancellable function with 
SSUWin>Setup>Input); 

- If input LEDs are OFF and the fault LED is ON, then the board is defective; 

- If input links in alarm are of 2048 kbit/s type, then either the signal is absent, or the 
frame locking detection failed (G.703 not framed or frame without CRC for example), or 
the required SSM is of quality level lower than the programmed threshold (cancellable 
function with SSUWin>Setup>Input). 

6.5.2 CLOCK Board 

When the fault warning light is ON while input signals are available: 

- Check that the inputs used are declared as "active" in CLOCK configuration menu; 

- Check that INPUT boards are faultless; 

- Check that alarm LEDs for INPUT, REF inputs are OFF; 

- If a fault is present, then check that the inputs used are in accordance with the wiring 
performed, of Input by INPUT Board or CLOCK Board Direct Input type. The 
configuration with/without INPUT board is performed at the start of the MANAGEMENT 
module. It may be necessary to reset the MANAGEMENT module (hot-removing the 
board and plugging it back into the unit) if an INPUT module is added to an equipement. 

- Make sure that the slaving time has normally elapsed after connection (15 min approx.) 
of the input link plus warm-up time (1000 s for OCXO clock, 3600 s for Rubidium clock) if 
the power supply has just been applyed to the module, and that the control stop of the 
local oscillator is not reached (CLOCK board Status menu); 

- Check that the GPS alarm LED is OFF; 

- If the LED is ON, see on the SSUWin>Detailed Status>GPS the status. If no Status is 
displayed, the connection (serial link) between the CLOCK board and the GPS board is 
not operational due to a badly plugged or faulty GPS board on the CLOCK Board. If 
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detailed status is displayed, check status of antenna connections and number of 
received satellites; 

- If alarm LEDs for inputs signals are OFF, then the board has an internal problem of 
operation. 

6.5.3 DIST Board 

When the fault warning light is ON, while CLOCK and INPUT boards operate without fault: 

- If all the green and yellow LEDs of signal presence are OFF, the signal is no longer 
distributed. The origin may be CLOCK boards, the backplane or the DIST board itself. 
Examine whether other DIST boards have the same problem. If they have, then CLOCK 
boards no longer provide the clock (problem in Master CLOCK boards or backplane 
connections); 

- If all the green and yellow LEDs of signal presence are ON, then there is a DIST board 
internal problem. 

-  If one or several green leds are OFF and the corresponding yellow led ON, then a 
redundant buffer may be broken or the load of the distributed channel is too low. 

6.5.4 Management Board 

When the fault warning light is ON, there is a module failure.  The board must be replaced. 

If no alarm shows on the INPUT, CLOCK and DIST modules, the signal is still processed 
normally even if the MANAGEMENT module fails. After replacing the MANAGEMENT module, 
the configuration of the SSU has to be rebuilt. 
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7777 AppendixAppendixAppendixAppendix    

 

7.17.17.17.1 Pin Assignment of Front Panel ConnectorsPin Assignment of Front Panel ConnectorsPin Assignment of Front Panel ConnectorsPin Assignment of Front Panel Connectors    

7.1.1 DC power supply connectors POWER –48V 

Pin Signal Description 

A1 -48V DC power supply,  –36 Volts to –72 Volts 
A2 0V Power supply return, -48 Volts 

 

 
A3 CASEGND Case grounding 

Table 7 - 1. DC power supply connectors POWER –48V. 

The above view is the front panel view as seen by the operator. Pin A1 is on the left of the 
drawing, and at the lower position on the panel. 

7.1.2 Connectors INPUTS 2048 kHz H1, H2 

Pin Signal Description 

1 2048kHz+IN Input + 2048 kHz, INP board 
2 STRAP75+IN Strap + installed in 75 Ω utilization, INP board 

3 GND Electrical ground 
4 STRAP75+INPRC Strap + installed in 75 Ω utilization, CLOCK 

board 
5 2048kHz+INPRC Input + 2048 kHz, CLOCK board 
6 2048kHz-IN Input - 2048 kHz, INP board 
7 STRAP75-IN Strap - installed in 75 Ω utilization, INP board 

8 STRAP75-PRC Strap - installed in 75 Ω utilization, CLOCK 
board 

 

 

9 2048kHz-INPRC Input - 2048 kHz, CLOCK board 

Table 7 - 2. Connectors INPUTS 2048 kHz H1, H2. 

For an input in 120 Ω symmetrical on INPUT board, connect + and – signals to 1 and 6, the 
electrical ground to 3. 

For input in 75 Ω dissymmetrical on INPUT board, connect the signal to 1, the electrical ground 
and cable braid to 3. Establish a direct link between 2 and 7. Establish a direct link between 3 
and 6.  

For an input in 120 Ω symmetrical on CLOCK board, connect + and – signals to 5 and 9, the 
electrical ground to 3. 

For input in 75 Ω dissymmetrical on CLOCK board, connect the signal to 5, the electrical ground 
and cable braid to 3. Establish a direct link between 4 and 8. Establish a direct link between 3 
and 9. 
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7.1.3 Connectors INPUTS 2048 kHz H3, H4 

Pin Signal Description 

1 2048kHz+IN Input + 2048 kHz, INP board 
2 STRAP75+IN Strap + installed in 75 Ω utilization, INP board 
3 GND Electrical ground 
4   
5   
6 2048kHz-IN Input + 2048 kHz, INP board 
7 STRAP75-IN Strap - installed in 75 Ω utilization, INP board 
8   

 

 

9   

Table 7 - 3. Connectors INPUTS 2048 kHz H3, H4. 

For an input in 120 Ω symmetrical on INPUT board, connect + and – signals to 1 and 6, the 
electrical ground to 3. 

For input in 75 Ω dissymmetrical on INPUT board, connect the signal to 1, the electrical ground 
and cable braid to 3. Establish a direct link between 2 and 7. Establish a direct link between 3 
and 6. 

7.1.4 Connectors INPUTS 2048 kbit/s B1, B2 

Pin Signal Description 

1 2048kb+IN Input + 2048 kHz, INP board 
2 STRAP75+IN Strap + installed in 75 Ω utilization, INP board 

3 GND Electrical ground 
4   
5 2048kb+OUT Output + 2048 kHz, INP board 

6 2048kb-IN Input - 2048 kHz, INP board 
7 STRAP75-IN Strap + installed in 75 Ω utilization, INP board 

8   

 

 

9 2048kb-OUT Output - 2048 kHz, INP board 

Table 7 - 4. Connectors INPUTS 2048 kbit/s B1, B2. 

For an input in 120 Ω symmetrical on INPUT board, connect + and – signals to 1 and 6, the 
electrical ground to 3. 

For input in 75 Ω dissymmetrical on INPUT board, connect the signal to 1, the electrical ground 
and cable braid to 3. Establish a direct link between 2 and 7. Establish a direct link between 3 
and 6. 

For an output in 120 Ω symmetrical from INPUT board, connect + and – signals to 5 and 9, the 
electrical ground to 3. 

For an output in 75 Ω dissymmetrical from INPUT board, connect the signal to 5, the electrical 
ground and cable braid to 3. Establish a direct link between 3 and 9.  
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7.1.5 Connectors OUTPUTS O1 to O32 at outputs 2048 kHz or 2048 kbit/s 

Pin Signal Description 

1 S+OUT Output + 2048 kHz or kbit/s, DIST board 
2 GND Electrical ground 
3   
4   
5 S+OUT+32 Output + 2048 kHz or kbit/s, DIST board offset 

(n.u.) Not Used 
6 S-OUT Output - 2048 kHz or kbit/s, DIST board 
7   
8   

 

 

9 S-OUT+32 Output -2048 kHz or kbit/s, DIST board offset 
(n.u.) Not Used 

Table 7 - 5. Connectors OUTPUTS O1 to O32 at  
2048 kHz or 2048 kbit/s outputs. 

For a 75 Ω output of the distributed signal, connect the signal to 1. Establish a direct link 
between 2 and 6. Connect the electrical ground and cable braid to 2 and 6. 
 

For a 120 Ω output of the distributed signal, connect the signal to 1 and 6. Connect the electrical 
ground and cable braid to 2. 

7.1.6 Connectors OUTPUTS O1 and O2, O9 and O10, O17 and O18, O26 and O27 
at T/F outputs (10 MHz) 

Pin Signal Description 

1 S+OUT Output + 10 MHz, DIST board 
2 GND Electrical ground 
3   
4   
5 S+OUT+32 Output + 10 MHz, DIST board offset (n.u.) Not 

Used 
6 S-OUT Output - 10 MHz, DIST board 
7   
8   

 

 

9 S-OUT+32 Output –10 MHz, DIST board offset (n.u.) Not 
Use 

Table 7 - 6. Connectors OUTPUTS O1 and O2, O9 and O10, O17 and O18,  
O26 and O27 at T/F outputs (10 MHz). 

For a 50 Ω output of the distributed signal, connect the signal to 1. Establish a direct link 
between 2 and 6. Connect the electrical ground and cable braid to 2 and 6. 
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7.1.7 Connectors OUTPUTS O3 and O4, O11 and O12, O19 and O20, O28 and O29 
at T/F outputs (1PPS) 

Pin Signal Description 

1 S+OUT Output + 1PPS, DIST board 
2 GND Electrical ground 
3   
4   
5 S+OUT+32 Output + 1PPS, DIST board offset (n.u.) Not 

Used 
6 S-OUT Output - 1PPS, DIST board 
7   
8   

 

 

9 S-OUT+32 Output - 1PPS, DIST board offset (n.u.) Not 
Used 

Table 7 - 7. Connectors OUTPUTS O3 and O4, O11 and O12,  
O19 and O20, O28 and O29 at T/F outputs (1PPS). 

For a 50 Ω output of the distributed signal, connect the signal to 1. Establish a direct link 
between 2 and 6. Connect the electrical ground and cable braid to 2 and 6. 

7.1.8 Connectors OUTPUTS O3 and O4, O11 and O12, O19 and O20, O28 and O29 
at T/F outputs (ToD) 

Pin Signal Description 

1 S+OUT Output + ToD, DIST board 
2 GND Electrical ground 
3   
4   
5 S+OUT+32 Output + ToD, DIST board offset (n.u.) Not 

Used 
6 S-OUT Output – ToD, DIST board 
7   
8   

 

 

9 S-OUT+32 Output – ToD, DIST board offset (n.u.) Not 
Used 

Table 7 - 8. Connectors OUTPUTS O3 and O4, O11 and O12, O19 and O20,  
O28 and O29 at T/F outputs (ToD). 

For a 50 Ω output of the distributed signal, connect the signal to 1. Establish a direct link 
between 2 and 6. Connect the electrical ground and cable braid to 2 and 6. 
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Outputs are distributed between all four DIST modules: 

O1 to O8  is piloted by DIST A module, 
O9 to O16  by DIST B, 
O17 to O24  by DIST C, 
O25 to O32  by DIST D.   

7.1.9 Connector REMOTE CONTROL RS232 

Pin Signal Description 

1   
2 RX Receive data (output) 
3 TX Transmit data (input) 
4 DTR Data Terminal Ready (input) 
5 GND Electric Ground 
6 DSR Data Set Ready (output) 
7 RTS Request To Send (input) 
8 CTS Clear To Send (output) 

 

 

9 TEST Auxiliary output RS232 – diagnostic of 
MANAGEMENT module start 

Table 7 - 9. Connector REMOTE CONTROL RS232. 

Control signals CTS, DSR, RTS, DTR are not managed at inputs and are active at outputs. The 
wiring corresponds to a DCE type interface (female). It should be connected to a PC with a 
straight DB9 cable. 

7.1.10 Connector REMOTE CONTROL ETHERNET 

Pin Signal Description 

1 TX+ Transmit Data + 
2 TX- Transmit Data - 
3   
4 RX+ Receive Data + 
5 RX- Receive Data - 
6   
7   

 
RJ45 

8   

Table 7 - 10. Connector REMOTE CONTROL ETHERNET. 
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7.1.11 Connector ALARMS-NURG A1 

Pin Signal Description 

1 ALNURGF+ Non Urgent Alarm, contact closed 
2 ALNURGF- Non Urgent Alarm, contact closed 
3   
4   
5 GND Electrical ground 
6   
7   
8 ALNURGO+ Non Urgent Alarm, contact open 

 

 

9 ALNURGO- Non Urgent Alarm, contact open 

Table 7 - 11. Connector ALARMS-NURG A1. 

7.1.12 Connector ALARMS-URG A2 

Pin Signal Description 

1 ALURGF+ Urgent Alarm, contact closed 

2 ALURGF- Urgent Alarm, contact closed 
3   
4   
5 GND Electrical ground 
6   
7   
8 ALURGO+ Urgent Alarm, contact open 

 

 

9 ALURGO- Urgent Alarm, contact open 

Table 7 - 12. Connector ALARMS-NURG A2. 
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7.1.13 Connector EXTENS 

Pin Signal Description 

1 CLKA_2048kHzOUT Clock CLOCK A board output 
2 CLKA_8192kHz 8192 kHz reference CLOCK A  
3 CLKA_OK Clock OK CLOCK A board output 
4 CLKA_TOD ToD CLOCK A board output 
5 CLKA_2048kbOUT- 2048 kbit/s OUT-CLOCK A board output  
6 CLKB_2048kHzOUT Clock CLOCK B board output 
7 CLKB_8192kHz 8192 kHz reference CLOCK B board output  
8 CLKB_OK Clock OK CLOCK A board output 
9 CLKB_TOD ToD CLOCK A board output 
10 CLKB_2048kbOUT- 2048 kbit/s OUT- CLOCK B board output 
11 TX+422 Transmit + RS422 
12 TX-422 Transmit – RS422 
13 GND Electrical ground 
14 GND Electrical ground 
15 CLKA_MS Master/Slave CLOCK A board output 
16 CLKA_PPS PPS CLOCK A board output 
17 CLKA_2048kbOUT+ 2048 kbit/s OUT+ CLOCK A board output 
18 GND Electrical ground 
19 GND Electrical ground 
20 CLKB_MS Master/Slave CLOCK B board output 

21 CLKB_PPS PPS CLOCK B board output 
22 CLKB_2048kbOUT+ 2048 kb/s OUT+ CLOCK B board output 
23 GND  
24 RX+422 Receive + RS422 

 

 

25 RX-422 Receive - RS422 

Table 7 - 13. Connector EXTENS. 
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7.27.27.27.2 2048204820482048    kbit/s FRAME AND SSM Messageskbit/s FRAME AND SSM Messageskbit/s FRAME AND SSM Messageskbit/s FRAME AND SSM Messages    

7.2.1 2048 kbit/s frame 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 7 - 1. 2048 kbit/s frame. 
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The 2048 kbit/s frame is built according to recommendations G.704. It consists of 32 repetitive 
bytes called time intervals (TS 0 to 31), the TS0 of which is used to convey data of frame 
locking and transfer quality (CRC4 calculated all over the issued frame). TS1 to TS31 convey 
the usable data, here not utilized, and filled with an idle byte. 

SSM messages are conveyed over one of bits Sax1 to Sax4 (x=4, 5, 6, 7 or 8) of the odd TS0, 
aligned on multiframe CRC4. Bits are ranked so that Sax1 (MSB) is contained in TS0 of frame 1 
and Sax4 (LSB) contained in TS0 of frame 7. 

7.2.2 SSM Messages 

QL SSM Code (MSB … LSB) Source 

Unknown 0000 Quality Unknown 
QL-PRC 0010 PRC clock 
QL-SSUT 0100 Transit SSU clock 

QL-SSUL 1000 Local SSU clock 
QL-SEC 1011 SEC clock 
QL-DNU 1111 Do not use clock (loop risk) 

Table 7 - 14. SSM message code. 

7.37.37.37.3 Format ToDFormat ToDFormat ToDFormat ToD    

Month/Day/Year Hour:Minute:Second Source 
03/20/2002 21:02:05 UTC 

Table 7 - 15. Format ToD. 

UTC appears at the end of the message if the GPS is the reference selected and the SSU is not 
in Holdover mode. 

The message is 19 or 23 (if UTC) characters long plus CR and LF characters.  
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7.47.47.47.4 GPS Antenna InstallationGPS Antenna InstallationGPS Antenna InstallationGPS Antenna Installation    

Before choosing the GPS Antenna and the connecting cable between the GPS Antenna and the 
EPSILON SSU, you have to perform the following steps:  
 

- Choose the antenna location, 
- Evaluate the overall gain, 
- Choose the antenna and cable type. 

7.4.1 GPS Antenna Location 

A place, far away from any hindrance of a direct view of the sky is necessary. 

Actually, the EPSILON SSU has to know the exact location of its antenna for the GPS 
synchronization. The EPSILON SSU determines automatically this location. 

The minimum number of tracked GPS satellites is four. And a vertical observation cone in sky 
open view, of a semi-angle higher than or equal to 65° (optimum at 85°), is recommended (see 
example below). 

 

 
 

Figure 7 - 2. GPS Antenna Locations. 

 
 
NOTE: The open view angles are given according to the criterion of a complete GPS 

constellation of 24 satellites, evenly distributed in solid angle around the earth. 
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7.4.2 Gain Calculation 

To ensure the correct reception of the GPS signal, the overall system of antenna / cable / 
protection (and line amplifier / splitter if used) requires a relative gain of 3 to 33 dB. 

 

Example: 

GPS Signals 

GPS antenna placed in direct view of the sky 

50 m of  KX4 cable (-30 dB typical / 100 m) 

G1 = 35 dB typical 

G2 = - 15 dB 

EPSILON SSU 
Lightning protection  

G3 = -1 dB  

Figure 7 - 3. Gain calculation. 

 
 
 
 G1 + G2 + G3 = 35 dB - 15 dB - 1 dB = 19 dB 
 Thus: 3 dB < G1 + G2 + G3 = 24 dB < 33 dB 

7.4.3 Antenna and Cable Choice 

Determine the cable route path, from the GPS Antenna to the EPSILON SSU, and calculate the 
cable length.  

The following information indicates the best antenna/cable arrangement recommended, 
depending on the different cable lengths.  

 27 dB Antenna 35 dB Antenna 

   Cables length (meters) Min Standard Max Min Standard Max 

  KX 15 / RG 58 1 10 20 6 25 30  Type of 
cable   KX 4 / RG 214 1 50 70 15 50 85 

Table 7 - 16. Antenna and Cable Choice. 

If greater cable lengths are required, the use of a line amplifier is necessary (only one line 
amplifier per antenna link is recommended in order to limit the noise factor degradation) 
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8888 Abbreviations and AcronymsAbbreviations and AcronymsAbbreviations and AcronymsAbbreviations and Acronyms    

 
AI Remote Alarm Indication 

AIS Alarm Indication Signal 

ALURGO Urgent Alarm Open contact 

CRC4 Cyclic Redundancy Check (4 bits) 

DEF Default 

DIST DISTribution 

ETSI European Telecommunication Standards Institute 

GPS Global Positioning System 

FAS Frame Alignment Signal 

HDB3 High Density bipolar Coding (order 3) 

INP INPut 

ITU-T International Telecommunications Union-Telecommunications sector 

LOF Loss Of Frame alignment 

LOS Loss Of Signal 

LSB Lowest Significant Bit 

MFAS Multiframe Alignment Signal  

MSB Most Significant Bit 

MTIE Maximum Time Interval Error 

NURG Non Urgent 

OCXO Oven-Controlled Crystal Oscillator 

PRC  Primary Reference Clock 

PRS  Primary Reference Source 

Rb Rubidium 

SDH Synchronous Digital Hierarchy 

SEC SDH Equipment Clock 

SEL Selection 

SLN  Synchronization Local Node 

SSM  Synchronization Status Message 

SSU Synchronization Supply Unit 

STN  Synchronization Transit Node 

TDEV Time DEViation 

TIE Time Interval Error 

ToD Time of Day 

TS Time Slot 

TTY Tele TYpe 

IU Interval Unit 

URG URgent 

XO Crystal Oscillator 
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